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CHON—Da0 DFHHEE. WERBIUBREADBBEEUTICERHELES,

ETH. 3—h—HLUE2ALa—F

Dorico 2 [£DULMZ Cubase & Nuendo LRILEMEEETAIVDUEREHL
FlLlzo 8M LO—F . YI—h—BELUTFUROEE#EE—XBHA T BRIZEDLE
-2 OB OH =LA ELITES .

LN ] Flow 1 in Uniiled Projest 1

Engrave  Play Print

o= e —

ABwitttrement by [LE

PR—FENTWBETARR: FEELY. KD 32 Evbhit QuickTime R—X
DI UIZh$>T Cubase/Nuendo DETHAIUOUMNEASH, §TIE—H%
MICERSNTVAETARADOKREBLEYR—IL, FREESSIZZLDTF—TY
FOYR—FEFELTLET,

MOV &&U MP4 T FIE H263 & H264 DEFAEHR—FL MOV Iv
7713 Apple ProRes. DV/DVCPro £&U Avid DNxHR a—T7 v &4 HR—kL
F9. AVl a7 F &, DVIDVCPro $&U MIPEG/PhotoJPEG 4 HR—kLET,
AIZETIL—LL—FDETHEYR—FShTOEEAD, —BILGTL—LL—F
(23.976. 24, 24.975, 25, 29.97, ELUV 30 JL—L/B) ITTRTERITHHR—
FENTLET,

HR—FENTVWBETARERDEMCOLWT,. BEUVETAHIZFERSNIE T4 1
KDBFEEFR—LSNTNBHKXADI—FERDAEIZDUTIE, Steinberg
DY R—b A bETELZEL,
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https://helpcenter.steinberg.de/hc/en-us/articles/115000808250-Video-support-in

-Cubase-and-Nuendo

ETADRS: TACz DR IO—ICETAERFTEET . ROETH (fz&2
[ET4ILLH 1 E5) TEETDER. EOETHEEROTIO—(IZR/MALT, 70
—CUITENENERLAEEICEHDETHERTEES  ETHTDRMICIFILUTD 2
DDHFENHBYET

BEE—FT. 7A—NIRIDBETAERMNTEI0—5EYYvILT . AVT
FREAZ2—MBTETH (Video)IrTFH{T (Attach)IZEIRLET, T71/L:E
REATOTHRERREN, ZCHoRFTIETHERIRTEE T, [BA< (Open)
9)903HE ETANTOCHMIFMEINET,
BAEE—FT.ETAMEMEINTNETAHILT—IOETAI7ZAILERSYIL
T, A1 LZAV LOETAZ RN T AHEICFAYTILET,

HEE—FTCETAZRMLIEE. TETADTO/F+ (Video Properties) 5 1
TRIDEE. UTOA T avhRRSNET,

& Video Properties

Video file: | /cue.mp4

Video frame rate:

Project frame rate: | 24 fps ~ | Use video frame rate |
Beat count: Beat unit:
Flow attachment position: g = f J. J
=] o L] (1]

Video start offset: 00:00:00:06 |5

Timecode start: | 00:00:00:00 [5‘*

(ot |

TET4274)L (Video file) IEXUTETADIL—LL—F (Video frame
rate) |l IEZEEAA R A D T4—ILRELSTEY  BAETAI7AIL DX /AR
ELETAIUDUNBRELEIL—LL—IDRRTFEINET,

ooz rmI7L—LL—bk (Project frame rate) (3. Y—H—HE LU R
R—=bD4URIIZRTRT B84 LI—FERET S7=8IZ Dorico HERT LT
L—LL—rEEELET . [ETADIL—LL—FEER (Use video frame
rate) 1) v 9 5L ETAIUOUNBHELIZIL—LL—MERESNET,
FIATESIL—LL—FOFEMICDONTIE. LTESBLTIZEL,

20— 742yFAUMIE (Flow attachment position) | TlL, 7H—RHOE
TAOBERBRAVEERELET ChISBEL-BEADEDOEHRTHEEL
E R

fzEZIE. 414 O7O—DORAD 2 INEFIZIFETAZBESELHMGE . THEOD

IR=Y Steinberg Media Technologies GmbH
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Ak (Beat count) | 74— /JLRIZ 8 ZA AL, HHDHELSL (Beat unit)1hid
4 P ERETERLETS,

» TEFHBEAF 7Yk (Video start offset) | Tl&, 7O0—DFAYFAVMIBT
RIRSNDETADIL—LEBELFT . 12EAILETAD 6 TJL—LHET
B|ENERSINZEE. ZDT4—ILRIZN00:00:00:06 | A NTHET. ETH
DEEN 6 IL—LOISHIBRTERIIHEELET,

» 54 L3—FEA%E (Timecode start)I TlX. JA—DT72yFAUMIEBIZEITS
AALO—FDEEEELET . 2R IE. TaILLA 1 BIEORBREEEIZE 1
FERYIYDZA LO—FAMFEESNEHBELAHYET . 2FY. 1 BHETEE
[01:00:00:00 1M 5BAFAL (110:00:00:00 1/ SRS Bi5EHH5). 2 EHIE
[02:00:00:00] (F7=(%l11:00:00:00]) M SEET 5. ELV--BEATY,

TARATOTANTADREEHKRZ-5. TOKIZEI )V ILET,

BAE—FCETAERMLIBE. [EFTHDTA/{F+1 (Video Properties) 14 A
FRIBBEBHICEKCEEHYVFER A REE—FTIO—DH—FEEY)YILT,
AUTFRIAZ2—MBTETH (Video) I FO/FT+ (Properties) % #EiRT 5
M. RBEE—FTI—H— RO LEHIZHATETADTA/IT41 (Video
Properties) IR 2% 0) v 03 5L FAT7OTHBREET,

ETHZRAT 5L BZEE—FDOT7O—/\RILIZHBH70—
DH—RDETFRIZI(IILL)—ILTAavE TETAOTO
/XT4 (Video Properties) |5 17045 TIEELI-ETH®D
1 IL—LODEA LaA—FHRRTENET,
ETADRRAINDERBICETA D4R DERAEET, DAV RIIEIELHEHER
WIREEL L DIGEEHYFETN. BENBRFYREETARRTINET,
REETAI7AILOEE: HFLIZETAIZ7AILIE Dorico 7RV TIMAIZESD
AFENEIDOITTEBYFERA, TOCIINEEZEBIEIETHEE. EELETET
ANDTIRADBELREEIL. ETAI7ANEBRIEETILENHYET,

ETAMNRAEINE=TODIMNRANTEE TAHZEETE
BUWMSE X, 70—/ RIILD7A—DH—FKIZ, T4ILLY)—
A\ o0:00:00:08 IWFAAVDIDOYICZABDELET(aVhRTEINE
ERS

TACzYMIETAEETSEBITE. HY)YILTIETH (Video) >l FdT
(Attach) IZ:&RL. RILETA 7ML ERFLEBLET . ETHTOBEDTON
TAIXHEFSINFT,

4 R—=T Steinberg Media Technologies GmbH
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ETAEZRMIETITEET S v—h— 2/ L0—F  TURBRHAGLE . BRZIZED
Y CEMEERT 526D Dorico DERETT AT ETAMNRASINTLELK
EBTHHEATEES . ETAZTRMLTUVECTH, IL—LL— S LO—REA

DfEIE. TETFAHDFO/F7+ (Video Properties) |34/ 7OJ #FEAL TIEETEE
T, AAT7aYERKIZIE. 7B—DH—FEEH)vILTIETA (Video)>TFAN
T4 (Properties)1Z:ERLET,

ETAD4VED: T4 K (Window)I>TET# (Video)1Z#IRF Hh ., F—7R
—ka—bAvbk [FA (TI4ILR) ZERTEE ETA IRV DRTRIFERTE
PYBZONFET ., VAR IDYAXEMEIF. TAD VM ETIRGL 7TV —
AV DREREICBVLWTRESNET,

JL—LL—hESA La—R: Dorico &, 24fps A5 60fps £T. FAYITIL—L
DEA LI—FEHEHT. REOCTLED TRy 3 LEHERIS THEAShS
IL—LL—rERIGCYR—ET . KEBXUDFFDOBRETHERASND
NTSC AK(FTL—LL—rA 29.97fps THH1=. KAYTIL—LDAA LT
—REERTIVENHYET, /oFOvTIL—LDEA LI—FDHE. T —
LIFEMMICHIOTIL—LDSIEFICESFHSNETA. FEVTIL—LDEA L
JI—kDIFZEIE. 29.97fps & 30fps DEICHLEERE 0.03fps ZIEOHEHLE LD
(2. B#ISEA LO—FBEBSDAXYTNTEONET . B 10 DERV=ES.
BALA—FRBEEMN 2 DTL—LADUIhLEINET, 59.94fps & 60fps DR
285 0.06fps DEEICDOLTH, RBEDORENERAINET,

Dorico Cl&., /> RFOvyTIL—LDAA La—RIEEKEIZfpsIMtE, KOvyT oL
—LDEALT—FIEEKREIZTdfps IHMFEE T,

B4 La—KRIEThh:mm:ss:ifi IO R TRRSNES, TNEh 2 HTHME. 7. #.
IL—LERDOLET FOYTIL—LD A LO—FIE B ETL—LOREIZE Y
XFEL TR TG EIaRVEFEALET, 2FY, /oRAYTIL—LDEA
Ls2—K(3100:00:01:05 | £ R RSN, FAYTIL—LDRA LI—FIE
[00:00:01;05 &R RENFET,

FSURR—bD4U R (F—R—Fia—rhvb [F2]) I2IE, @& QORFBEREIZH
PO TEALA—RERTTIILELETEET . ChEFRMCTBICE. BELF T ay
D34 La—F (Timecode)IR—U T, 44 LTARAFLA (Time display)1%l4
4L 3—FK (Timecode)|IZERELET

ETADEENYY: RAETADERNYIIE. ROT7OBELFRBLTHES
NFEIT ETTDERMNYIOEMMLGEEELRAHTHICIE. ¥ —Z/HNT
(F—FR—KLa—khAvk [F3]). Y—ILA—OTETH (Video) I T4 ILA—RELES
YL TCETAI—F—%RRLET . [ETH (video)|7z—4—I&. Tz—F—
DIV DEE. IReverb )] 7z—4 —&lMOutput ] 7z —4 —DERIZRRESNFET,

ETAI7I—4—%321— g 5L ETTDERNYIEI2A—FTEET,
ER= Steinberg Media Technologies GmbH
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RNITROTETAEMHERT S ETAVAVRVICE, BICBEANYROBREME
[ZXIET BT —LDEEIRRSINET , Dorico KNEEFFEILELTNSEEIZE
ENYFDRBETRTHRDTIAUNRIRIINGIGES (L. TRERTE (Preferences)]
DI (General) IR—CDIFE (Play)l o avIchbEILRICHEAYR
#% = (Show playhead when stopped)|Fz v I RyIREFIZLET,

BEAYFIE FSURR—bI4O RO DREEY (fast-forward) / HZRL (rewind)
REVED)VIT M, F—HR—RIZTUFXF—DHAHEEE. [+] & [] ¥F—%EH
LTEINT CENTEET  F—R—FIZTUX—HREE L, [F7] TEERL.
[F9] TRZEYERITTEET, Windows DIHFEIL [Ctrl]. Mac DIFEE
[Command] #REICIHIIET. 1 BTEHEGS 1 TIU—LBRTHREITEET,
Mac Tl&, 7729230 F—05ETIAILET, RYa—L BEDHELE, AT1
FTHBRAEGEDHEDI=HIZO AT LIMERT 5186, [Fn] ¥—16iE8 TREFIZHS
BIFNIEESEWMEENHYET,

I—h—: X—h—ElE ETAOBEDES LI—FIZ@ SRS T, B<
DGBRFBERNICHIU-EOINEERLGREMBZEZRLEY, v—h—(3, IG5
(Write) 1> Y—h—% 45 (Create Marker) 1% #iRT 5h ., F—HR—Fa—thy
k [Shift|+[AIt]+[M] (F74/Lk) 2EAT 22T BENYROBREMEICEMT
EF T, N—D—(FRATDORETIHEBICRTSN, T—H—DIR)L (FIAILE
TlXIT—h— (Marker) LT TREND) (&, TANTA/IRILDIT—Hh—
(Markers) 17 I\L—7 2B T—h—TFXb (Marker text) ] 7O/ \T1H, F=l&
HEE—FOT—H—RILOVTIIhEFALTRETEET,

R=A—/\F )b I—HD—&, BEE—FOT—H—/ )L
CHEDTIO—DOX—N—EYRALRTTOROTHICH -
BI+1RAVED )T HIET NRIVICERENT A5 R i e
EETEFT, TN EAFT TITT—A—DEFME (S
EREFHT. TREROY—H—LEDIA La—Fh [
OO TVBBEREIERTT , FY—D—DRALO—
FETHRRNMIELLE, I—D—RILDERNDIHEET S
T4—ILREZTUVDYYILTEEAVSI U THRETEE
ER

R—A—IRRILDERD 3 FHIZIENmp.1EWSFRIL
ML TLET, ThldlNmportant] (EE) OBKT

ER

BELGT—D—LE BEMGRBITIRZRITIELIENBOTEETHS L
ZRYY—H—THY, Dorico DTURBERMEICEVTEELRIER-LET,
R—N—%FELHI—H—ELTERET BIZE, BICTmp. S DOF v IRy IRES
VITLEY,

Markers

10:01:11:03 Scream

6 R—T Steinberg Media Technologies GmbH
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R=N—DTHAY: I—H—DTHAVIZEAT AT avE, BEF T avIcH
LLTEIT—h— (Markers) IR—UIZHY ., CCTIEAA LOA—RESRILDELL
ZEICERETANEZRELEZY, MOKSERBERMLIYTEE T, T40T72
)—. DA ERIEFRAUMI&KD YA XEET T HIZIL. [7$F (Engrave) [T+
YbRBA)L (Font Styles) |IOI?—hA—TFXRAT+b (Marker text font) 15
zIEMR—h—D %A La—FFA74+>b (Marker timecode font) IZ#RELET

T—h—DRRUBEER: TIHILITIE I—h—[ETILRATLATIRTIE 1
BLOEBROLIZRTEIN, N— b AT IFTRERTRINFEFR A, T—H—DRTE
MBEEETBHICIE. TERELE (Vertical position) 1Z#Ek D E (Above
system)1E (XD T (Below system) | OWLVFNMZHRELET , £=1E. 2
ALI—FEADERICT—D—Z2RTTIHIIELBIRTEET,

AATIZHA La—F%EFRTRT %: Dorico (&, RAT7IZHA LO—FRADHRILGERE
ERL T, Z2ICRA LO—RERRTEFET . FMLO—FDERERTTHITE. L
AT I A ToarDIw—h— (Markers)]X—C%ZRL T, [EERE (Vertical
position) 1z 24 LO—F DK (Timecode staff) JIZFRELI=3Z T, 8440
—FORZKIFWMD LICEEE (Position timecode staff above bracket) (<.
ZD LIS LO—FDERERTESE DIV AMIIIAVNI 7 —ERELFET,
BE&IT B2 LO—R#RICE TS84 L3—FDHEE (Timecode frequency on
timecode staff) IZ2ELT. 41 LI—FDFRFE 1 INEITE MBTLE, (%
ERT (FALI—FDERICI—H—TZTERTTHIEE) MOERTEET,
HEE—RTY—H—%R599 T % Y—H—IZFEE SN2/ La—RDEIEM
BRESN, BASNEETAOBEDIL—LIZHEMICH I TONET, Rt E
[SRRSNDEIT—A—DMEBEZE R T HICIE, BBEE—FTY—H—ZFEF-IEAEIC
FS9ILET, CNITEST, JA—DFBRMEENSY—A—REEFTDITRTOT
URERETERYESN, JO—ORBEEICE, T—HA—DMEISEE T HHHRD
TURNBRESNET (R—h—2EIZRSYTTHETURNENY, EIZRSYS
FTRETURDTNYET ), COV—ILIEL VT IVIEHEREL MF=T . fz&Z 1Ev—
h—% 1 DRSYILIzEE FNLVRICH AT —H—DUEIIEELI-FET. T
UIRADEEIT 1 DRTIDOT—H—LIRRIZBEDENSESHHEEL, SDECHER
TETWFERA CORIITEEGREERIOVTIE. BEE-FTEA LYY
DREETHEVES,

BEE—FTRALISVIERET S BEE—FOAMLNYIN—FHSh, 70
—DTURERIIH T DEELGFEET T4 NIVITITER S EINTGYELE E
TADRRGEINDE, I—h—,H A SNEETADEHDS VIR BEE—FD
ARVNTARTLA DR EEIZERTIINET  FM LMSYIDFDTURERSE
THE T—H—DEENITINEFALICEFEINES , TBLGRAUMITURE
BEEATEHIILET. BV N—DEELOEFAMEDRENBTZICTHAFET,

7TR= Steinberg Media Technologies GmbH
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TURERE: Dorico DFHEEETH A TURERFK (Find Tempo)l 1 FO%
FRALT. 70—2AK0OBULTURERETEET . COVrVRDIE, BBEBE—F
DI—H— IR NIZH B TURERFE (Find Tempo)lRE2LE0) v HERMAE
id-o

@ Find Tempo

Flow: | Fiow 1

Beatunit:‘ J | s - J | = I = |“| Terpo range: - [il——igll-
50 bpm 200 bpm
Tempo increments: m Allow Increment by 0.25 I_

Tempos found: Markers:

BPM IFQ NFO AFOQ Timecode Text Imp. Fr. Off Time Diff.  Not. Diff.

Selected tempo:a=171 | APplY [

—
[TURERFE (Find Tempo) V4V FVZEFERTHICIE. T—H—/ R THL
EtH 1 DOR—H—HDEE (Imp.) [TIEESNTLIRELNHYET . COI1UF
DTIE. FA—FhDEBELGEI—H—ITKL. LA FHICTESEFREVWMIEIZERS
FIITTBBEREC. RELTURERETEET,

RO O—)LHSEEDHEOEEEERLTHS. BRIOTTUREE
(Tempo range) IR/ 7 —%#ERALT. REXMRET 5T RO TRELRZFER
LET HD B ETUREREZRET 5L, ZAIDIBRESNI=TUR (Tempos
found)IDYRMDEFINFET . RHESINI=TURIE. EELAI—H—DFHITL
— LA T DFEYZENTNDI—H—DHANSIE TRz TL— LD FHIZHEL.
BIETYRRRTSNET,

IFO.NFO H&U AFO DIEIFENENEELRY—H— (IFO), EETIIHNT
—#— (NFO), ZLTFRTHOY—Hh— (AFO) DFEHIL—LEEEKRLET,

HRIDOTIT—h— (Markers)]) ARTlE, MRHEN =T (Tempos found)]')
ARTERLETURD LY ERNEONET YRMIFET—H—HERTRSE
nEOTOGERLETUREFERLIGEE0EMISEThIZIL—LDO$K (Fr.
Off). INIA LT O TRHOEINIT—H—HIEBELAEDERZE (Time Diff.).
BrRUEERLEDLEIZEDTL—avTROSNDEY—h—IBLALDE
(Not. Diff.) BAEFRENET,

RBETURNRESTL, [RESNF-TUR (Tempos found) ) AEMSZDT
g R—T Steinberg Media Technologies GmbH
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UREEIRLT.URNTONLER (Apply)lRE2E0)vILET, chlzkYTOo—
DR EISERLE-TURMEBINESN, DT UREBRIEFTRATIO—MSEE
SNFEY,

HFRS

Dorico 2 Tl&. AFREDRNICET HFEEEELT. REICET S 2 DOAT

AVETHAVICETS 3 DDA TV HFHICEASATOET , FEERIC 1
DIORTIDEEDEEDEN EHOERD L, DFYTURPYN—HF)L
T EDHMBTATLERBEDMEIZ 1 DOAFEEERTLEY., KIENS
LITE AU TENEREGIAFES 1 DERRLEYTESRSICHYEL,
noDATaviEndht BRICIENEEINSEEICE VW TAFRESEZEIL

=E5@ENHYET,

BFREDEELEIRT S BFEEDEEICEHTIHA T avonTnnzgE
RIBICIE. LAT O T avcHHFsni-IBFEE (Time Signatures) | X—
CEREFET

Time signature position and size:

o

#’:,:.

ANa¥4

T e

I\-F

~

Show at system
object positions

Show on every staff Show once per bracket

AT aVERETDEE. LAT7 I OB LB GERES M TR IRLET,
BE.TKFEWMEIZ 1 DFRTR (Show once per bracket) | ©T#EA TS H0D
fIE(-FKT (Show at system object positions) [ ERXIA 7L A7 rDAIZFER
LEFTHINELT. LaA—TAV T REDATHERT B2 D/IN— L AT IRTIE,
BELYKRELHEFESEERTS-OICITKFIMTEIC 1 DFRF (Show once
per bracket) |Z#IRTHEELHYET,

gR=Y Steinberg Media Technologies GmbH
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KEFIMZEIC 1 DRRTHIBFRES: KFMSLICRREINLIKREGHRFESE.

BEDOHFRELYKIBIZKEGZIENDS, KEARICHOHZAR—RAHLKIFIZ

REBYET, COH BFREBEDTHAVICETEIA T avDEFLHE T
BOZEEBTTHLET . CNELATOMEToavIicHiksnz-I{BFEE (Time
Signatures) IR—U N DEIRTEET,

Time signature design:

I
> tﬁ(;

el
|

o) ——— ﬁij v
~ S

Normal Narrow, serif Narrow, sans serif Plain font

[+Aa—+tY2 (Narrow, serif) |77 3> Tl EHMMEIEFREEOHFOFO—
TAURREERLET . CDTA M, Britten, Birtwistle %5& 20 tHf2htED
HEICRBERDHBEDICFERASALOICBLNBREBLES, [Fa—H 1)
7 (Narrow, sans serif) |17 3> Tl&. Helvetica HEDT OTFRI T+ MM
LI ANEBEETHH I ITA OB FEFERALET . COTAVME A, T
LEBXUST —LZFEOLI—T1 T BIZERSN - REIERINSEDIZHE
METWET , LEEOIDYIZ. TTL—2T42k (Plain font)J4A T3 3:8RT
EFJ ., ChIMaFEREATL—2 T+ (Time signature plain font)] (M%&
(Engrave) > 74 FRBA )L (Font Styles) | THR&EIRE) TEZELI=TAUMEE
RALETA. CHICEFO—F(EIAVTURRREMILD T+ MEEIRT 525 S
TIHLET,

ToB TN BOKRERIZEENENIBFREEN 1 DT DORERSIN, TIAILLT
FRFNMDEEARICHRFASNTOET  BARTKEFNEFAOEERICIEE
FRBNRTINETH., TIHIITCIEEEDHFREIVERELGYET, F1E
MMTOHEANTZERDORTELRKIZ, TN TN DOEBRICEELYREVVEFEEN
RINSINET, KM LI 1 DOBRFESERTIEIEIC. BEERITESR.F
EETERPIUBEBEROKXENE 1 DOBEFEEEEEFETSE 1 2DJIL—
TELTHRAKIITT BIHEE. BEA T aVEHLTIAFRES (Time
Signatures)IR—YIZHBEIL. TEBBLUF—R—FHAOKHEI (Brackets
for percussion and keyboards) 1% EE—D X{EIMELTHRS (Treat as single
bracket) |IZERELET

10 R—= Steinberg Media Technologies GmbH
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BLE. TLERS LU —LBEDOLI—TAV YV AOXATERKIZE L TIE, AFEE
FBEXFEROPLTIIEERKIHZAOSNDBZELHYET . ChEBERT DI,
HBEATIVEROTMAFES (Time Signatures) I X—J (2 EIL. [ KIER
[T HEEHS RO (Vertical alignment relative to bracket) 1% E#iZ
(Top)lIZERELET,

%EF T3 DOIMAFEES (Time Signatures) IXR— TlE, KiEIMIZ&E TN 5L
ROBLIZ, BFRBEORTERLIEETETET, K TIHILLDF T3y
[T RTDFERIZRT (Show on every staff) [{FAEDEBEDRTIESIINT S
MAxHELGYET, RN 1 DDIHEE (1 1/4 £zl 125%), RN 2 O 3
DDBE (4 FrIE 400%). BLUHEA 4 DLULDEE (10 F=lE 1000%)
T. ZNZNERIfEEIBRESNTOET,

HEA T PDMEDIEFRES: 1 BLOER (BLUATar LT D
DFER) D LD, TORPIN—HNI—OBEDRETATLDAEIZR RSN
SAFEE X KFEAM., DFYIXLDAR—REHEBELGEWF AARHYETH,
EEARDAR—ADHEENKEGYET , COBDPFERESDEEIL Carter
1© Henze BEDEHMRICEHEMDHBRY THEASINSILIZEY, 20 tHiTZEE
LT7—rBEDOHHTREICERLEL

HFEESHALICKRTEINDERE. UN—FILI—) ., TUR, VE—MEIIGZEN
LICRRSNBERLERLTHY . CNIELATINFTar Ol AR
(Staves and Systems) IX—C DI BA TP HL (System Objects) |z 3>
[ChdFTavaERALTHRETEEY,

EROLDIVFREIF. TIAHILITEBEDHEFESD 2 BEOHFAXTRRS
NFEITHB. CNIEFEAT a0 DMAFEEE (Time Signatures) IR—I12H D
MAEA T O ORDEEBICR TSNS FIEEDEE (Scale factor for time
signatures shown at system object positions) | TEETZ£ 7,

RO LEDAFRESFIVIXLDAR—REHRLEN O BOFEWMEFEEDT
PAUEFATLHIILIETNEEDLETEHYFEE A LOLIBFESHIN—FIL
T—IR0TURBRESDNDIGE . TIHILNTIEIBFEEMUD T AT LEAIC
BLOVES, ZOO BORVNTHAUZERINIEENODAET WE /MK
TESH. —EBTLHRMABHYET . TURPIN—HILY—IFIBFERETDLIC
KRSEDHEEIL. FEA T3> DOAFES (Time Signatures) IR—2I2H 5
[TFUOREEUPIN—YILT—IITH T HAFEESDHE (Position of time
signatures relative to coincident tempo and rehearsal marks) 1% FIZE &
(Position below) JICZELE T,

1M R= Steinberg Media Technologies GmbH
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RO LDOAFESHNABSLESONDHEIE. LAT7IMAToa>nliNGE
B (Bar Numbers) |IX—JIZHHTHBA T O IMIBICHFRENHSHBERT
X/ EiFESZEIERT (Hide bar numbers at time signatures at system object
positions) |ZA VIZL TMNIBE B EIERTRICTEET,

RO LDOPFREBIE NHRO LICHRRFZ LT HH. ERZLTENERIRT
EFETHBEORTHECHDOEERXBMNT HAFLS(E, HEOKRTHETEA
MASNET  ELZCICRABOERLHY . TAA T2 LIEESHTVDEEE,
LEREOBERLE-EENMERASINES . REDERIL. BFEF T avDlBFRES
(Time Signatures) IX—(2H A TINGRIZH T HEF] (Alignment relative to
barlines) 1A 73> CITHLVET,

HFRBEDOABNEETRIRSINDGEE. TBIE A FOTTIELGLAIC FEMN
ERAZOEFEFEALTRARINET . P BOERORKEERE, BFELF Ty
DIAFEE (Time Signatures) IN—J(CHABEFOTaL—avELTERTRS
h32BOfEE (Scale factor for denominator when shown as note
duration)|ZZFE§ 5 LT A FDORRERLIEE AR TEET,
ZRENOBT RS, BEE—FT AR+ REF—FFETIRRS T EERAL
T. BRI cEET, [{RE (Edit) > RPavE vk (Reset Position)]
EERTHE. ATV FOBYBELNTEET .

YATLNIYY

DRATLESY IS HEROTRTOERICEWNT, /NEDEMEBIREIUVER
DEREBZIZT S, A—F—AUF3—TJ1—ADHEFXRTY,

5]

Fy s

|

L
B

| ]

7

——

mf
SRATLMIYIIE TIHIVATEFRITAD IR TRERIN, CORTR/ERTRIE
[Ea— (View)»TYXTLRSYS (System Track)1ZRIRLTYIYEZ ONET,
RERDIGE . VAT LNV IITHED 1 BLOERDO LIZRTSN, EETES
BATY D, bV D LICTIRRAVA—EBESELHERERICLGYET VRT
LEZYIDRRENDDIFEEEE—FZITTT,
TIHIWNTORT LN YIRRRENENESICT 5 E . NTREHE
(Preferences)IDI 2§ (General) IXN—C DIEa— (View) 0l avIZH b
IOz HIML AT LMY %R T (Show system track in new projects) |%
PYBEZTHIICLET,
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DARTLNSIVIED VDT BE VAT LNV EFIREEIZLRYE T, [Shift] &
BLEAMD N D LIZHEL AT LNSVIED ) 7T HE BIREBEZILITS
CEMNTEET . VATLARSYIDNBRENDE VAT LM YIDHRELIV LIZE
MORZUARRENES  BIREBE O ER/IZIFHIBRAREY  BRICIES AT LR
VI DBRFEATIEEINDT R TDAVRMILAV D EFEERT 2RIV DH
Y. Tz VAT LISV TERLI/MIDSHERED /NI EZDRD/NETDRE </
HEBATHRIVHHYET
SRTLMIVIDRTRPIC [AIN] EHTE DRTLMNSVIITY LT ) IR DBRE
EISIECI=T)YRSAUNERREN,[AIL] ERLENLYRT LN YIESVIL
TRV & MTRD—BEERTEEY EREITASENEHEMDRIRE
RI#RIZ ERREFDMIKISEN T NHIBREFTFERDREINRTSNET,
YRT LSV DBRIG—EHLEDTT  NHOEA D, Y RT LMV DRER
BHADEA VALY AVEDTRTOEFOREREN O 1 DDT I aVERIT
FREERIERSINET T VAT LSV DRERIL, D RREITLEoIYLA
FILEGWEA YT HEBEICRREINET N R—CEa—¢FrL—E1—0
PYBRICEV TILRFREAH RSN ET,

F—rA—3>

Dorico 2 (&, TR KXV MIDI A F4=a7RAVMO—5—DREZFHIEHE1T4
St=HDFHLLNY—ILEREBLTOET, CIZKYBLEE—ROHEEEATRIRESN ., &
DFEEICBITAFEDREIZEFHEZRTIDELYET,

L ] [ Can mota moderato in 2018-04 #lay mode
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AL LSV BEE—FDARITARTLADRLEEICRTEINDZA LSV
TR, TRz IO TURERETEES . TURD I T4 hIVGRRICTEVLTIE,
BEETURERIIBIROELEL T RRICTUREREZTHESEEE 2 AEOD
BOBEZELELTRRSINET  EEDNVRILEIIVILTRSVI T HE. TDRA
rDTURERBTEET . YVRRAUA—DBEICITNSKTUoRDFZEAHLED
RTRSN. ZTORAUEDTURDBEENLE T —F N\ IN/ONET,

AL LMY TIETUORERDHBRIERLTEES, hEY—IL TSIV IED VY
LT . FRDOTUREREEEAA TS, YIRRIVE WS -FFRICBBSES
L EBROTURERZ—EICEEAHFET, TOREEMERSNDHEEIL, UX
LTVIRDBREIZEYRESNE T, UXLTVIRDEAINSNFEE, IIRELS
VYIRS THRICBESE SIS AT URERDHEMN LRV ET,

FURHOMN TERMGREHEILEZERT DX SAY—ILEFERLFET . X
EZERIRT 2 RAbET )L TH D, REEMEILDR THETTFSYILET,

BEE—FICTBVTHREY—LFLESAOY—ILTEASNI-TURER(E, X0

TEIRIBEDNENEH LI EEETEI20. TIHILNTREE—FTIEHARFELT
RTRSNFET . CWoDTUREHNRIICRBSEZI5E . BEE—FTRIRDSZ. 7
AT RIILDI TR (Tempo)l T IL—T(2HBITF A (Text) ) FO/\T4%

HELTRRSEET,

BAE—FCTURERZHIBRT BICIE, BIBRY—ILEFERLET . 21 LMSYIRA
DRAUEE 1 DT DUV ITBIETT, EDTUREENEIBRESNFES,

MIDI 3> kO—5—k5v9: TFREFNDAARYILAURZ, MIDI avbA—5—
T—RERETH-ODL—UFRRTEDELIIHYFEL=, SDECARRTES
L—2lE 1 DEIFTIN,. ChTEHRO MIDI oo bA—S—OT—2%ERTE
9,

MIDI A hA—5—L—2FRFT BICE F—bA—230 F—2EERT DI R
FoLAURD RSV IANYE —IZHF ISR EBESN = REVE V)V ILET,
ADARYILAVERD TS TIZ. ZEDAVRMSIAVKIE T HL—UBRREINET,
AVRA—5—L—YDESYINYE—D A= a—hb, T—H2%EKT S MIDI av
FO—5—%BIRLET, URNIIE 127 38D MIDI OYF4=aF7RIAVbE—5—
FTRTINEFNTVET , TAEANT TITAASh TVSIVO—5—IF, A=a—
RIZTRAYRY (*) TEIAMTFIFoNFET,

MIDI v bB—5—DA—bA—23 T —2DERKICIE. 24 LMSVIDTURE
BEERTHDERLY—ILAMERSINET , SaEY—ILIXE R DR/ REIERL
F9. 90T DN —EDHEEFTVITHILET UXLTYYRDHEICEIZE
RADRAUIEEZRADET . SAY—ILIE 2 DOEDRMIZEH LN TELEIC
BT OMEERLET, HIBRY—ILIEBETFEDRA U EV)VILTEELET,
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MIDI MEZHL: MIDI 77/ EEEHTLE A/ LIYIE LDV MIDI avbkO
—S—hSuHITBEREN A — A=AV A RUMRT RTIFA IR ENE
?—0

TAT12

TAT4DEE TREITBIEVSERDAZ)TEILLETEY . A—T AN DIKE
FROEE CIE—RRMEGEETT . N AT TOFERANFICZENTT L. EREND
DIFTEHBYFEL A ZEF/EIIAVUNDESR, 12EAILEBLEETHERINDS
EEHYFET 1 DDEILIAVEERD NSRS AVIZHTT. FhEL D
RICEEETHILITKY., KYENGESOF R, FIEHALERICKOIREN AT REE
BYET,

P -

|

(.
1y

3. |
iy “

hilll

b}

——
=i

F .3 I
e —_

TAD4TDINIE—D DERLIE. HERDEEERY I DT HIBO TR BFLET
HYEETLI=AY. Dorico 2 BN TA T4 DI=HDFHEEICLY . ChlTHESI
ibf:o

RNEBBISHAT 5L, RBIETHIAVRARYIAVMIT 4 I4OFERL . 5
THERODBE. TNTNDERITHETEIINILERELET . ZIhBIE.
Dorico B BEICCNLDEREZEELET  AEPIL—LRYYICEVWTHRET
BT A4 T4ot 0 av DELITODVWTRIEETHOIBLEREHYER A T4T4OM
FHER D& TRAIAE=(X#R T 35354, Dorico [IBHEIZIELTETAI1P DL
[CA=V > DEREEHNICRIIEET . T4J10872aV M R TLIZE. byy
TANDETDIETEERLET . HU Dorico N2 BHEITEMERDEIBRET
BONET,
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TATAOEERT D TA4J4DME, 230 TL—V—NEETEHAURAYILA
MIBEWTHOAMERTEET , VATL—Y—I(F 1 ADEEEZEKRTDHH.C
DAVRACYII AV ERENIT B LIETEFEF A, — A, 2V avTL—v—lE2E
NRILEBEERT DEHDABEERT 570, DBNTEHENTEFT , FIFAD
FAT4OERERT BIIE. TA IS DBABARAVNERIRL T, TR (Edit) >3
% (Staff)l» [T 7+ %Z%EE (Change Divisi)1ZRIRLET, UTDF (705

s —
NRRENFET,
@ Change Divisi
Divisions
L Soloz
L Solod
* Solod
81
Bz
Staff labels
[ sefitabeis  ~ | Al iNone) v | Flset 2] Afwow [Z] A2 ootee [3] (u]iollst] gl
=] 1a Bl - Eifruirmm
[Academica « | [Regutar ~ | B acopt [2] 2e2[ooopt [7] Al m
Solo 1
Cancel m
|

FAT7AT LBDVANMIZ, §HET1 4PV BNRRENET . FRICT1T4D
EERT AEECIE TTutti]EWSTIRILD T4 I4030h 1 DEFHEELET,
TA T4V D)RADTFIZHAIT I3V N—hb VIRARBLUEISI>D 2
BATDTAT40aVEH MR TEES , VIRMEMT BIZETVAD T4
23 %3EM (Add Solo Division)17/h2> () Z. 273 &Emd 5(2E &
92av DT 1491423 %iBM (Add Section Division)l7/h%> (H) #91voL
FI . BMLAEYIRMNEREEID 3V EEN TR TITEMSN RIS L
FTAERTEDVIRNE KUYV DHITHIRIEHYEL A HEEE TES1
(T T IV DORERIZE D=2, Dorico (F7A—hDTL—V—DHR#EHRZF
HA EREDNETNEIBEL TSI EERTHRELTLVET,

TAT4LAVIZRTSN TS INIVEEET BICIE. F470T LEDY XA D
T4 I42aVERIRL, TOIERSARIL (Staff labels) |73 DT X AR
ELFET, I a0INNLE, BHRBROFRRME., €730 DERDICERICE
RSN, BEFEICESN HFEICE>TITILI7FRAYNEFERLT. EOTRIE
FERIL—Y—DEDEEEEZTIONERLET
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FAT7OYT EEDT4T42a0 DR OIEET DERD T+ I403%EFIRLT
[ —F%:EM (Add Group)lR4Y (B) 25Uvo3dE. €9 avESHIYT
W—TFEDBIELTEFT  TIL—TIRNNWE. T IL—TFeShi=T«1 T4 3>
[CBT 5T RTCDERICHTIFRBZ T, AVRARIIILAVME DR EIZRRSN
FT T IL—TIRNNERETIEIE. TT12—DTCLIZRTEINSRIEFEA
LT.TEXKFR (Full Name) | LTEEFR (Short Name) | Z BRI IZHRETEET,

R&IZ. [T4J4P%ZEE (Change Divisi) #4705 D TFERIZH B TL—Yv—
LEIETW—T4L%ERT (Show player or group name)lE LU T5L 3
B%%&K T (Show section numbers) DA TLaVEFRALT. COTAI4PTE
BSNDINIZHL. LAT ORI a0 DIfER LB (Staves and Systems) ]
R—UDHREIZHS AT avIzH#S (Follow Options)]) ., EIZRRSHED
(T&:% (Show)l) F-IFBIZEERICTS (TEER (Hide)l) DLFThHTATS
AVDEEE LEETHINEIRETEET,
TRTOEEN KOS ERIOKIZE VIV ITDE TA TP DEEMNERSN, /I
ARDBRFSNET , CNIFEBEE—FICBVWTIVARSYT Fz(E [Al]+H[]/[—]
L&Y TATA O DEREETIIMNBEELERTEET . TATAPDERTERS
NIZVYRRBLUEYL AV THRESNZBMDER (. MIETHINILHHED
RIS SSh ., HEORBEEN SR REINET, T4 PDERELYRIICI=
VODINRFERISNEID—ELHEEE . HILLTELTRTOT1 TP DFERIC
FTAVAPDEELNHLIMBEEFTI=V VO BERINBIMICRTINET . HE
FFLWNT AV DRERIC. BEOEBREBRICEREANTSETTY,

BEDTADCOLEEEHRET D BHEOTAISOERERET BI(E. T+
TASDHARES TN ILET , [F4T4SEEE (Change Divisi) 15 70
GBIV TERETHADEIBYET. TS o av aHIRT 558, Kl
BT BHI-C DBRICRENTU B HFHIREN T, BEBICRESNIOTE
BT, 152 aV EBIRT BRI, MIRHREBDTFAIASDBEN ST
RTOEHEHRT HCLESTTOLET, BIZ, BAIB 1T IS soay
ERDOBALISE. TRCOBHIEASNET,

FATADAVEEET B TAIASD vt —SEESIH BT BBE . FE T A
T4 D—BOHERDYET BHE . EREMFOFIET, HIET HHHI=
SHBATAIACOEBEERTEET, MRICRTENEREIL, ZOMBTRY
DF IS OEETERENADEIRERENET , AR TESLBH T
(SOEBEFRTHBAE . TONREROMBOMBLEISTAFT,

TATAODINE—DERT T B TATAODNE—CERTITHEEE, A
ERELTRTHEDEFFIIRFZLZRL, THRE (Edit)>TEER (Staff)1>Th
vT41%{8T (Restore Tutti)IZ:ZRLET , CNITKY. . FAT7OTERTTHIE
B Ay TADEI Ay 1 DETNLREST IA D T4 T DERISERE
17 R—=2 Steinberg Media Technologies GmbH
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NET, COEENEBEORTHEIYAICHIEE. TP DEELMAEDRK
THEDOMIZHD/NEHE(Z/NEFO—EIC. BEMNIZI=V U DEFFNRRINE
ER

A=V DNytE—D: TAT4PDERTIAZV UV DEREERT DL A DL
R, SBIZFMODTRTDOTA TP DERICHAHRLEFNRIRKEBIZAYET,
COEREEMNHEET HEFTES . T4 DRERITMAF-ER SO T
TOERORLERFICRBENET,

A=V tE—CFHBILOTLT BIZE TEa— (View) M TEHEKRBFDHS
— (Note and Rest Colors) > T4« =Y #iB (Divisi Unison Ranges)]
TREUNYBZONET . A=V 2D /I\vtE—ICBRT5EFPRFEENIL—T
RRL.EBDOTAT4oDITITILERBILPILLET .

BLY—RADBHEEHDERICRTT IDIEEHRLTNETHS=8. Dorico H'
TA TP DERITAZV U OEREBHRRSEIRIIRASITYTILOELEIC
[EDLIENYFIRDAHBYET . ChIET TP D/ —U 0 BtRT HRTE 755
BRDBIAGIE .. T=ET A IS DRy t—C MR T LR ELDMEBDR T HE.
WFRNISBVTERRTT . FTRETONDHIRIIRS—ICET 2D TT . T4
4D E—CBIR BRI RIZH =5 RX5—IF,. T4 IS DRERICITRTINE
A SRISHLT BIZIE. TA TP Dy E—C DRABIBEE RS— DR LIE
FTCRIHSE. TOERETAVAVDERICFETIE—TFTUFR—ZANET, [
BROBED MR CEFELET . T AVF—TRIFAMDERICLMERASN
FHAD, BFEHGHEES (ANTEVLE) FEEIZLEBINET,
TATAPDERNAZJODITITILDERIZREIRAVMNIBNT, A D
EREEELLIFHESMNERASNTLSIEA. Dorico [LEYEFEHLSETD
ERICEIERLETH . ZOBE. TOEZRDBREDAR—IUTNETESIL
DHYFET, ATRETHNIE. AV DEREFALBE WL SICETTESLSIC. T4
ANV DR THREIYAIOECNCEULGEBOEEEZHFALTZE
LYo

TAITADERERINIL: LAT I ToarDIEREMB (Staves and
Systems) | R—(2H BTEERSAJL (Staff Labels) =53 IZ(E LLTFD 2 D
DFE=EAToavNEmShTWET,

» S I—TR%EFKT (Show group names)]lE. IREDLATIFTERIANILD
EREBHEBMOVT A EEAANRTINDFZEITHES>TVDIHEEDH
BREGYET . DA DEEZE AV RRYILAVRBITHDDSTTAT4PD
TIW—TIRDBRFEINET,

= 5238 % KT (Show section names) (. TA T4 DT IL—T LA
ARDIAVRE DR TSN TONDNEIMIEDOLTHRETEET . COERED

ARG ERFIELTIE, /A= AT IRTIE, T4T42DEI IV BDRTR
18 R—2 Steinberg Media Technologies GmbH
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FLETH BEDERINIVIEIDELZWVEELHYET, TIIHDERITT

RT (=) Violin | WEETBEIEABELNTHY., ERSRNILERRLTH

FRGERANMAILEBMEINGEMEEHEICCORELFEALET,
AT avDEREF. T4 I4P%ZEE (Change Divisi) 154705 DI FL—
Y—ZFE=(XTIL—T&%EFKET (Show player or group name)l1H LU T54 3
L &EB%RE (Show section numbers) 14+ 7T avIc&l, T4 IS DERTE
DERFEICLEEETINFET,
TAT4DEE: K))—RATRH. TA4T4PDITITILIETART VIRDTT
DZILEEDT 1 DOFYoRILTEBEIND=O. BLD5E7 3V MIZHFRSN
HERIIBRESINTLVET , Dorico DEGEDY)—XTIE. T4 T4 D/1\vE—
RADEIIRLE LV a3V EBROF Yo RILIZEYETT, T4O42D 1\t
—COBEICBVTEN-RHMEEHKIETESLIICTEFETT .
R—AWERIZETDT1T142: R—hILDEHILIVTL—NY—IZT1T4D%FE
B9 3B 4. Dorico [ETA T4 DI\ E—U BRI NDERTDBERDKRTHIE
(2. S—hREIDRENEBBMICRTLET,

A ey
S. %&ﬁ:}j‘z< % 1 téﬁtﬁi
J o
a Dec-o S. a De - o,
fa)
2
AV L7 |
~e/ r
fac - tus

FIeTATATo DNy =D O MEDR T RETIE. TA4I1PDERTNTE
NIZREIARTEIN, RYED 1 DDERIZSUA—5FELET,
COEEEEET BICIE. BELF T AL DI T4 (Divisi)IR—TI2HHIEZE
R DHARRIGICHEIT1I1P DR (Indicate divisi at end of system on
vocal staves) |+ T3V EEELET,
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7

TV T IR EAEDNNYE—DDIDYITERLTHEINKE/\vE—UZRLET,
hiF, B EERRITER T OROFENERT 0. RO HHBERDER,
HOVWRKIYERNBZLGN—DaVERTT DEIGIGEEICEASNEY , Dorico
2 X AVIT DI NIES 5O D BENEHEEZBEALTOET,

— i —

e e———
ossia g eaate o

H : A‘J'T’l"-—
G
L

AV TEEBMT S Ay 7EEBMTBICIE AV TOERERTITIEHHFF
BIRLTHOTIRE (Edit) >33k (Staff) >[4y 7% LIZ4ERX (Create Ossia
Above)1FE - (XA YL 7ZETIZ4ER (Create Ossia Below) | Z:&#IRLET  E7/
POZDOMDREREFERT AU RALYILAV D EEFERLTLT, L FLWTH
DERERTI DAV THRLETHSGE. EFERLEFEROBADTT)
FIVEERLTO G, THyL 7% LIZ{ERL (Create Ossia Above) | E =& 4y
7% TIZ{ERX (Create Ossia Below)|Z:&iRLE T,

FTVITEERTEDDIE, VATL—YVY—INERTHAVRAMYILAVIDATT &2
9230 TL—N—MNBETEIAVRARYILAVNIE, T4 T4 DFEERRLTILEE
ROEBMIFITEAEE A, RIFRIZ FTERFINDAU ARG JLAVMIL A VO TE
EBMTEFER A AVRMIILAVMIEREITGLTETOWT ORI A v 7%
RARCESFTH, ERORCAICIE—EIZ 1 DDAV TLHARKTEEE Ao

AV T DINvE—DDFBEE. BIUA VLT DRERNERADIETHREIZIEHA
FARTREINFET , CNLDHAFIE, BBEE—FTERLTRSYI LT, F=(&
[Af]+[«)/[—>] THYDTEET , HAREEBITAYI T ORBHES LUVERTHE
LRBELET,

AV TEHIRT B AV T DINvE—TFHIRT BIZIE. AV T Dy tE—2D
Mim(CHDHARFZHIBRT . FEA VT DN\ E—CADEFREIEKFE
BIRLT. THRE (Edit)>[FE%& (Staff) >R ZHIR (Remove Staff)1ZEIRL
F9,

oL TEHIRT BRI, BAIH S RO HEHIRLTOELRYIE, SHIE
BCRIRINGLGESZITTHERURTAZEITEREL TSN, RIFERLME
[CAYTEBERT S BRIETBURRINET,
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BE: TIFHIITH AV TOERTBEEDERD 2/13 DRESTRRINE
T, COERIL, HEAT DMK (Staves) IR—DI2H BV T DIEE
(Ossia scale factor) I CHREITEZ T,

TV T RRTRSNDUBERET S TIAINITIK. AV TDERETTRTD
LAT IMIRREINET . AV TEREDEED/N—I AT INIDHRTYT
BHER, RATDHITRTT B ERIFINEY LD GERLHYET LAT I
TV TERTRTINEINEEIRTBICIF. BEIZHL T, LAT7IMTLavn
M= 4B (Staves and Systems) |IR—C DAY 7 ELVEMDE

(Ossias and Extra Staves)1 /3> (2H b4y PERT (Show ossias) %
FUoFRRIEATIZLET,

INETIREHE S AV T DINFRERIST DAV DERIZEDLSIHEET DM
DNTIE, HiREN TV S EETHEASN TOARERAN KON FELET A
IO TDEFRBESTRT VNI NG/ NEIROMEICHHEREL T, —EDHIRAEE
TV T DEIRMELR THEDHAZAMVDERICHEESEFT A, thD HAR
HIFRTHEDH THASE ., SHIZHDHERIEF VT EA D DEREF ST
{(fEESEFEA.

TYITEAMDERITIEEIEHLEE. —HOHRMIIMDERIZFERT DL
BICIEEED/NETHR (BE ISR ZFEALETH, B HRIEEHDDHYIZHEZRED /I
B CA YL TERAESIEET,

Dorico [&. SNHT R TORERAIEES T 5-HDFTLavE BEF T3y
DOLINE#R (Barlines) |IR—2(2H B A w7 (Ossias)l o ar TIRELTLVE
9,

FILT AV ARSI AV DAY DERDEICRTEINDIGE . 2EALET /D
AFERDTICRTINES YO TREIL, HFEA T a0 ONN#R (Barlines)
R=2DATLavDBRABICHIDOLT | BITAMUDERERL/NERTHES
ENFEY,

VT DINI: AT DEROERAIBAEossial EWVSEEDINILER S
FTBIZIE. LATIA T a0 DlER 4B (Staves and Systems) IXR— D
[F 9o 7ELTBEMDEER (Ossias and Extra Staves) 127> avIZHbIFvY
FDERIZSANILERTER (Show label before ossia)|1ZA >V I(CLET , HRAZLSA
IWEERT5A8E. Ty 7D (Ossia label)1ZTHR45 L (Custom)]lc
BEL. ThRELDA YL FSR)L (Custom ossia label) JITIEEDTHFAMEA
ALES,

TV TDINVIEERIRNIVLDINST TR IR THESN, FEF T3
DIFEE (Staves)IR—UIZHBIAYL T (Ossias)l o avICEEINDIERE
[CHSOTERESNET . 1 DDA VI THERITALIANILE, RIFEIMTRT Lo
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YO TRERITAGRIVIZIE. ENENERZERERETEET .
INTDERCRIBEIER T I 5497 Ay THAINE DR P TRITAE -1
T9 53545, Dorico [XERESN-ITUTZILDERIZERELXFITRLT, BF.
B ESEE . (TR ZDMDTA T LAY FRERODE THEICEIZHEIELLELKS
[SLET . EAICHTRTERBORIERAH T HICIE, FEA T aoDlER
(Staves) IR—CDIA YL 7 (Ossias) |7 avIZH B AV TRKEE O
#DIER (Extend staff lines at start of ossia) IB LU A YL TR T HEDE
B OEER (Extend staff lines at start of ossia)IZZELET .

HMBREFCAVLT: VI THABHLMETHIRLEZDRDEERTRT 5155,
BEDEREFAKRIC, AV T OERES LRASERRORABNETHEESLER
IMENFEENHYET , — AT, EDAYITHEMD AU ARG IL AV TIIENT
EZBRRAICT 510 MR DORIRMEDERMESHELIVRASHOLRLEESN =5
REBHOENOT VO THBRTIONPFELLVGETLHYET,

Dorico [FLVFNDAELAEEELE T LAT VAT ar DIk AR
(Staves and Systems) IR—C DAY T7EIWEMODHRE (Ossias and Extra
Staves) |7 avICH HHHEEFE-CA Y7 (Ossias crossing a system
break)Z#X BHEIMBNEEEE®HS (Include in preamble) | F /-1 EREE
EBniEEZKN TS (Exclude from preamble) IR ELET,

BEEARDAR— T FIOTERIET DA DEREDT IAILEDEER (.
LATORA T v DIZBEFRDAR—I2Y (Vertical Spacing)IR—2 128
RSN YO FHRRMNSERET (Ossia staff to staff) IDEICK>TRESN
£9 . COEMIL. EEAROMMERNADEZEEZITERE A,

BRIDA Y THRREFNNBT DA DEREDERIE. BEESY., FEE—
FCRERDAR—I UG Y—)LEERTHIETRETTEET MR TIEERIZ/ >
FILBRREINET N AV 7 TIHAELOA YO TREROBIBEIZ/N\VRILA
RRSINFET,

VLT EBE: AV THERRDEFEIBESNFEEA,

AVARY LAV DERDBEEET D

Dorico 2 Tl&,. 7O—DEEDRA VR TAVARY LAV DEREEBEIZBMNET-
(FHIBRTEET 2ERIX ET/DHEET 3 DFLIEIFAULDEREZET DL
IR EMDRELATREICGYET,
BINOEREERT S AVARYILAVMIEMDEREERT BICIE, BINDE
KROFBMET, TO LN TICEMDERER RSBV EROEFE AT
ZERLT, [RHR (Edit)>TEXK (Staff)>I LITGEZRZEM (Add Staff Above)]
FIEIFICHERZEM (Add Staff Below) |2 &#IRLET . ZDHEITEMD L
HPMER S, BN (FFIFHEIBR) SNzEROBETRTHARDARRINET,
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AVRARYILAURIYOTL—N—DEDOTHITNIEGYEE A, £V a0 TL—F
—MNEETDAIVARIIIWAVIDERERDBIIEBTEF A, T, FTESRTYLD
AVARYILAVMZIRERITEMTEEEA.

BMOERZAEIRT S BMOEREZHIBRT DICE, BMOERNERRSATINS
MEBEDHAREEIRT DD, HIBRTHEET. HIBRLE-VWEROEFE-IEARFTE
FEIRLT. T¥RSE (Edit)I>T5ER (Staff) >[FERZHIFR (Remove Staff) |Z:#IRL
FT o SNIEAVRRIILAVRDIELONOHDER. LEAFET/ OEFEILE
FOERDEIRICHERATEETT (=1L AVRARIILAVNIBT 2T RTDHE
ZHIRTHEIETET . BIZ 1 DULEDRERARTINTUORTAIERYFEE
Ao

EMOFB/ROBABMEZEIRT S: ERNMEBROEPCTHRIBEETRT THEE,
DFERELLODETDMETRRFIFERTIZSEVGEEL HEE2ADORS
TRARSELEWMEELHYET . ChiF. LATIMFToa> DIz AR
(Staves and Systems) DI A YL 7ELVEMDHE (Ossias and Extra
Staves) |y avIsEBmMEnzIBRFEIFELFICETHEBRLEIEMDOHES
7~ (Show extra staves across full system when starting or stopping) 7
VORYIRTEHRELET .
EHDEREFRRIZTSD: AVRMYILAVMIER SN EBMOERIE. L1T7D
rATLavDIEEAMDAR—S VY (Vertical Spacing)JIR—SIZHATHEED
EREFOMAMYILAVIDER D#EFREIERRIZTS (Allow individual
staves of multi-staff instruments to be hidden) 147 3> DEEFZ(+FEE
Ao

Aoy FFEE

AoV A, HICEBICIFIEESNEMINEERR T HILEEREICIETRT
BEHIZERINET . FEDAMEVWRS YD aE—RIZ, MEEETENILES
BIT—ESINBLEERENFET  MEIMFLRIV alE—RIC ERTHRE
A LIEHEREINDH, BEITOVTIIEFICHRELSLROEBIREINET, AIFEERSY
DaRnEE. BFEVXIIRELEIENDEELHYET  Dorico 2 (. 2D 2 D
DAZYLAFEBIZOVWT, SELGYR—MERHBELTVET,
ATy atilE: ASVVARBELTEMT 5 —FEHELGA KT, AFvP 1 EEEER
$HIETY ATV aABEEERT AL, NEDEHBEERSY A TEOHLHIENT
EFT . AUEHEFEREBINST. RSV aDURX LA BBMITRESNET, 2L
ZIEX. 44 OIMEITIE 4 REFDRASYV 2 4 DBNRRIN, 6/8 DIFEIEFFR
4 RERDRATvah 2 DRIREINFET HFREELEETHE BEHADRS
v aDTalb—2a vt BEMICEHINET,

Aoy afEigiE. 1 DU ED/NEEERLTH S, TEEEE (Write) 1> TR5v 298
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g% 1ER (Create Slash Region)l%:E&RT Bh\. [Shift]+[R] THIEEEDRYTH
—/\—%BE, Tslash]EA AL, [Return] ZHLTRYTA——FHELET,
BRLETaAL—2a v OEBEICRASY D aBlEMER SN HEEBIT, TIHILRT
FRSVL1DEENZREBETHEARTIN, AZVaNBEO—THAHAILETR
LET (CEEMZT BRI TE2— (View)] » [RFYIafEBZEMEER
(Highlight Slash Regions)1%74 ZIZLEY ) xS5w 1 4618 ) BIIA {4 B &8 T 41
BIZHAHN\VRILEFERTLHE. migOminMNoEgZ L IFYUIENH Y TEET,
F1z. [Alt]+[—)[—] TRV EE OB EIE DB, [Shift]+[Alt]+[—]/[—]
TRIYDAEED T AL —2aV DBRENITHEAET,

RSULABHENET D HEAFERORT THALEHEBESRLHE RS
v SEEE 2 DISHEIT BN BELFEELHYET . CNICE. FrLubER
RSB TRV AEEEREITHAMEICRESE. BRY—ILHRYIRADIEEHY
—IWEP)v T BHM. U] EAALET RSV fBEAFYLYMIET 2 DI
REISN., LA X EFOBEBORBMED/N\VRFILERIZRSYI 5L AR—
AR TCEREEDARZRETEET,

Aoy afBEICHITA M R EEBRFESICBLTE RSV alftmERRT
BEMEIMITDNT, SESFERREHAMFELET , Dorico (&, TIAILETE
EHRFOTAL—2av DRIV aAllF A RERTLET 2L, COERE. %
EA T DIERH (Notes) IR—PDIRFYL 2% (Rhythmic Slashes) |t
9avITH B ESHFICHETHRFY 2 (Slash regions in compound time
signatures) |4 73> CEETEET,

ATy a® 5 ER: Dorico 2l RV ARBEDNRT FAUNMEBEEREINT
WET . chlE, BEF T avDIER (Notes)IN—CDIRSyL 2 FFEE
(Rhythmic Slashes) | L3V ICHATHEBHYDASvi 2 (Slashes with
stems) | LTRHBHELDASY a (Slashes without stems) %k ETHEIZ&KY,
BEDTHALOHNSEEDNEREERTEET,

AoV afFEFE: RSV aBELYLERLG) X LOEREETALEEEF. R
Iy atERREERALET . AV aMERRICESANE FEDFEIZLD
ARNEFSIKEILTY . L BEEELEBERIEITRTLEEESN. TIAIIT. A
ALEBRFORMEONMDYIZ 1 KORTGYANERDE 3 RICKRTINET,
BEOFIERSY AMEREICER. BLUTOHLITHRAFETS , TOEFFOM
BOEYFIREFSN REOFEMICRLEBECIFETINET,
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AU AFEFEEOBRDANEHRICEHIBT HICIE, TREFE (Write) T RSy
2 {+EFEE/ER (Create Slash Voice) 1% #iR 3 50\, [Shift]+[Alt]+[V] (T 7+
JLR) DATRURZEAALET, COaATURIE, FRIIELDFEHEEBMT S
[Shift]+[V] < FEBEUIGE>TLVET,

[Shift]+[Alt]+[V] O RERYRLANTHE BMENDRTYL A{FEFERD A
AT HEHYDRSY 2 (FRELAZE). FEHBYDRASY 2 (FEETR
E). MELGLORSYY ADIETUYEDLYE T FEDFMERR. TrIvbDE
BlOA2 D —E—IZ[ESh D DEBMEINSEHOEENRRINET,

AU 21— EANTBRE. CORTYVAFFEREIEIFDAARYILALDED
[ZCHEEERTE. [V] TEHOUYEBZZTEHOBIZIE, RSV FEFEEHEIR
RICEFENBELSIHYET,

RASYVANERHDAATEERT S RSV aEFHIC) A LEFESTEEA
ALERICS, FEAEFRELORS YD AICHYEZ WMEGEX. RSy am 55

1 D%EFRLTC. [4RE (Edit)>[FE (Voices) > [ RFvL 2 FFEE (Rhythmic
Slashes)INOFE T HFMANTERRLET . I AZa—D L REDODFH
(Normal Notes) | Z:E R 5L, FEITIFEDFIICEEIN . FEFOMNET AN
DERRDEvFHNETLINET,

AL ABEICEVWTIE, fBEPOVNTNUADRT Y aF IR EMN R T L
BT AHDNRILEZIRLTHS. TO/TADFTRIy 1488 (Slash
Region) |7 IL—7IZHATFHRBIL (Stemless)ITA/\T4%&F 23 5ZET. R
FYVADTFEHYERELLENYEZONET,

REDAMEERET D FEHYDRAIYLalZENTIE AV At EFEOT
THILVEDOFEDARAZLAZICTENTEEICT 0. ZEDFEERLCAHETIE
ETEFET, [EE (Edit)I>[FE (Voices) " FFIBRETIAHILTLERZEIZTS
(Default Stems Up)IE = (X[ FEBFT I+ TTFRZEIZT S (Default Stems
Down as desired) 1%:&IRLET,

ATy aBEICEV TR, SBEPONT O DR Ty aF - (EFBEENE T L
BELTNHODNURILEERLTHS, TO/RT DIRFy a8 (Slash
Region) 17 IL—71ZHATEEDRZE (Voice direction) | 7O/ \T4&A (235
LT . HEDFRZEETEFEY,
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ERNODEUEBEZEEET D TIAIITIE RSV ERTY A EFRIE
WINEERDE 3 RBLEICRSY aZRRLTVWFET  EREDMEIXLT D
BCFIBTEETEET, TNENTRSYL 148 (Slash Region) 1= (X &FHF
LR (Notes and Rests) 17 IL—T12H B X592 DEIE (Slash pos.)170
INTAEFAVICLT. HETHEERELET . [0IDEIFFERSE 3 RISKHIGL. T
SADYHFIELIZ. R1FTRADBFETICRIV 2 E2BHEIEET,

AZUVABEATRDOKRR: AoV 8ElAVNIDZEP TRIBEFRTLTLS
HEE.TONHDERYDEAZEARFTTIEDHOIRENEIN L. DB RFINERDRFE
CREBIZHIMEIMNIESTEDYET , TIHILETIE RV B IEFTIR D
MAIHICBVTAZLLNHERFTEOLSELET, f1ZL. TaNRTFADI RSV
2 %818 (Slash Region)1V IL—T(ZHATRIRGEBE&LYATIDAKRFEIERT (Hide
rests before start) IBSUTR THBIYERDAFFEIERT (Hide rests after
end) 1T O/NTAEAUITTHE RFDORTENMHTEES,

ATV AEEHERNILIE D RSV aFEFMAMMDRTVS 1 fFEFEE-
(FIBEDFEEXIL T HI5E . Dorico (. ATy atEFHDTI+ILEDEE
LOEEZEEZLT. 2 DOFEEMIEEINERLENESICLET . RTvSadt
EFEBOATEIFDAR—X (L, SLEA T3> DIFEE (Voices) IR—UDIRS
v A BBEDEE (Rhythmic Slash Voices) 17 IL—T(2H DA T avIckYRE
SNFEI,

Aoy A LBERITES: ITERYIVNTRIVI2EFERATHICIE. TITESFFYE
##&% (Edit Percussion Kit)1¥ 170/ %&F T (REE—FOTL—v—/
RILTHESRTL—V—DOH—FERRAL T, AV AR A MDA THFRAMAZ 2
— WA TOTEREET )5 RELITA3—TDT I3V N—DASYL RS
Y2 BOLVWITIAZEERATALET ITESRTIMNIFEHYEIFELGLD
ATV aEBMTEET FTEB/FYMNI 1 DUEDRSYL 2D EYREEBMLT,
ELGHERLEOMEBICRETEEY,

BEROAAZENTE, RF—Z2FEALTEFINDELGDHIVRAMYILAVMEE
BEIT 5. FYMIBMLIZRASYATHNIET R TBEELICEEN., ITESRF
JrDMDEFDANEFESTKEKRICRTYL2EANTEET,

ITRBIXINDAS Y AF 5 BEDRTIMTERABOARTINET, TR
FIFENDARARYILAVRDRTEATIZOYVEZDE RSV alFRRSNE
‘A,
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INGTE—FEES

INYE—REES I, BID 1 /NERL 2 MEIFEIE 4 DMEHICEFENSGEREE oIS
FCICIRYIBRT CEEBRREICRLET . COEADKREITEREICESTIEEIC
BEFALGLOTY  ERDMHIZOIS>TERNEDTEFESHSIN TV DL D ELEHRH
Do AYTEENMRYBREINEER RGN EINDERSDEIEYET A,
INYE—FREBERAT HERACTRY, BYBRLTLWSIEAHABIZHOME

ERR
T T 0
T

INEAY E— RS BYBRLARELGDIEREAALIZER, RONEIMDSIAFEY ., /ET
JE—FESERTIEIHBEDEDOYFETERIRLT (CIIFERIFIEEETEEY).
[E05E (Write) >T/MEiY E—MEBIZ{ERL (Create Bar Repeat Region) 1% 3iRL
FY . COFIEICEY . DEIYE—MEEAERENET . 1 IETE—FESHEIR
HRELRICRTINET, LEZOADYIZ, [Shift]+[R] THIELEDIE—LEED
RyTH—N—%RAZ. [%IZ AALTHID 1 /IE [%2]THID 2 /MEI. [%41T
BID 4 IMNIDE—FEBEERLET,

N E—FRIEEER L= RICIEBYRU/NEIREEE I HICIE NEIJE—RES
DLFhh, FFEHEORNFEFREICHIAVNFILERERLT, TANT
1R LD NG E—F 4B (Bar Repeat Region) 17 )IL—712H 5T IMNET#L (No.
bars)I7ANTDEZEELFET .

INEIYE— B E. T4 TEEN KB TRARTINET, BRERTOA/
AIEYYBZBICIE. TEa— (View) TN E—HEiZ543E (Highlight Bar
Repeat Regions) |Z#iRLET,

INETVE—REEBE DU MT 5 Dorico [EEIRIIZ, /NETUE—REBID LI, #2Y
RLEBBOAV N —ERRTRRLET . TIAILLTIE 4 NS EITHYY
ERTREN, BRFQDEN1IENDILSNET  12EXE 1 DOBEFDO/MED
%12 3 INEIEO/DETE—MEEAELZIES. 3 DHD/IMETIE—EE A4
EAVURENET , TIHIEDAIUNEREERT BHICIE. BEF T avnlp
Y E—FES (Bar Repeats) IX—J(2Hh AN E—FEEDRIBDHY UM
n /IMNIC EIZFRTR (Show bar repeat count every n bars) %X ELE T, ho>
FE—YIRRSELEVMESIE. [IMFYE—FES DAV RD 5 (Appearance
of bar repeat count) |ZIJEZR7< (Do not show)JIZERELET .

. ;
N
N

CDTIHILEDFRFEIL, B2 O/NEHE—MEEB T EIC EEETEET, TO/T
DTN E—HRELEL (Bar Repeat Region) 17 IL—7 125 AT hDH U MEE (Count

frequency) IE=IEMAHULDHNE (Count appearance) &4 (CLET, THD
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VFBAREIE (Count from) | 7O/ T4%A4 (29 5H&. Dorico BhHOUNERIRT
HEHLIEETEET .

INERVE—FREBDAVUNDITAUS A X REAIVEEET HIZIE, [HE
(Engrave) I>[ 24> F X424 )L (Font Styles)IT. ["MiiUE—FEBDHIU - (Bar
repeat count) | DT+ h AR ILERELET,
INVE—FEB D LICKRTRENAGBFOFMAMEL. FEET—RTYVRFEEE
[Alt]l+ KEI¥—THy T RHILTRETEET,
INTE—RREBZETIIL—T1E9d 5 HAMOBLWIL—XBEEHDEEICHL
TIX MVE—FRREET IL—TITEHILICE - TETDREEEZTTENEFELLY
HEPHYET FLAE 4 DNERBOBEZFDEEICEVLTE. £o1=<RAL
200 4 IMITL—XERDFIIKRRTEET,

J ) @

[V 4 s J ¥ 4
A0 F A y A
|
_I r
)]
- J o g [ 4 L 4
B i e A P

FFELRDESIZ 4 PMERERICEST IL—TIITEFT,

J ) ) ) 2

s J o g7
Vi F/ i)
I r
4
H 1

HFEY—RHUTEBYFEREAN 1 2HD 4 MHITL—XE, RDEKIIT 3 /)
EDVE—FESEZFEALTRTTHELTEET,

VNSV 3

.7 S 4
|
I— r

F /740
B 7
F/7 7

GI—FIEBDZTBIZIE IMIE—FEEOLNT b, T=IE/NEE—NE
BOmMIRIZHINITNODNURILEERL, TCOMNFRHIEIZTLV—TF{E
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(Group

every) ITO/NTAEEEDNERICHELET 4 NHITIL—XETHIEfLE
(2 3 INDUE—RRBEERTTBICIE, FEA T avDlIMNGIE—MES
(Bar Repeats) IR—IZH BT IL—TDORY 3 MEiD5 8 (Appearance for
three-bar remainder of group) 143 /i E—FEESZERA (Use 3-bar
repeat)l[ZERELET

[Shift|+[R] TRYT4—/\—%BN T E—MEEEERT HBETE, FIL
—TLEEETEET . EAL T%1,4IEA DT HE N IMNIDVE—FEE%E 4
INIZEIZT IV—TEL . T%2,41EA DT HE 2 INIDVE—RELEE 4 INEAT
EIZT =T LFET FIL—T1ElE 1 /NEiL 2 DNEIFERIE 4 DMEICELNTOH
EETEET . ANSN-HFORAEHOENETHASE Dorico M ¥IETLI-15
BlE. TIAHILMRE (VIIL—TeiL) I2BYET,
BVEWSEBIEELH DO NETIE—FEE DT L —TIFEEICTHEI&S
[SEEL TS,

1 DITFEEHON /NI E—MMEEICRASN/NEIZEESO&EEIL, LAT7T I
T3 DIINGHES (Bar Numbers) IR—JI2HATRAFE LU ASh -/
NE—rRESD TFI/MMIBESOFHEERT (Show ranges of bar numbers
under

multi-bar rests and consolidated bar repeats) |+ 7> 3 &4 I12FBHZET, 1

DITFEEDONT-/NEIE—FEEDTIZRRTEEY,

wmEI A DOEHY—IL

Dorico 2 [&. RILFR—Xr, THRTA—FEYT1—RA L TFTERADEZDHE
HELVOE—LGE  RHF O—RNEIEEET U ANT 22 HOERHREY—ILE
%ﬁf:(:ﬁkbfh‘i—a—o

VILFAR—Rb: AE—LI-EREAN—RANTHLE EREBETHEEL-KEAAS
FOEEAMOHBEZIEDDVILFA—RAEFATESLIICGYEL R, BIRLE-
TATLN 1 DETDGE RA—AMERIFEREFIKEDYE R AN, BET
AT LAERENTLSIZES . Dorico [, TATLMNRBIREN TS AL R RH)L A
UhOBET SEETHANSE B LDIER .1 FBLOAUAMYILAU S EDERF)
[SERSNI=TATLDME . BLVEREFRNDT RTDA VAL AV DB
RRISERSNETATLOMEZHIBL  EIREBEICINESLO>BERDIE—%E
ELMTRYRILA—ZAN T, COEBEEDIIELFET,

AVRARG LAV DEY E DRV TREIRSW TLS15E . Dorico [EFBYESIVR
Ry JLAVRDER 1 D 1 DEERMDOR—AMEBERGLET , ChlZkY., fz&
ZIE 1 DDAVRMY I AVIDLEBIETEZIE—L. ChEEBD AU ALY LA
UNMIRILFR—RF B, SEEDEFICHINODDA U ARG ILAVNERS T
EFFET,
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BIRGENIE-LI-ERLYENS1HETH. Dorico [FERDIE—ETLN
B CRRGEEDE AV RYILAVMNIR—RMLET A GERGEENIE—L-ER
KYURWEE. Dorico [FBERDIE—FTLLM TTESEITZMRRYRLT, FEiR
BN S EAESBENKIITR—RMNET,

EEXENTORERICEETS: THRE (Edit) >TBXERIRLTIRYFIT (Paste
Special) ]I A=a2—(Z 2 DOFLLVATURABMESNEL-, BIlEShf-a<>
Rl EDERICFEE (Move to Staff Above) | LT TDEERICTES) (Move to
Staff Below) | T. SNH6DT 74 )LD F—R—Ka—rAvk(E [Alt]+[N] &
[Alt]+[M] &7aYFES (THRE (Edit) >R ETHIET (Cross Staff) > LD
KFETHILT (Cross to Staff Above) | T DFERFETHIET (Cross to Staff
Below) DT 74 LD F—HR—Fa—rhvk [N] & [M] [CEEEISETLET),

NEDIATURIF BIRL-EREEDTATLEREDERNCTYRY ., ThE
EDTOERIIN—ALTEEEE 1 DOBRETRTIEFET, INIEIFEIFL
WRTETLERIGHEETT , F-EZE MIDI T7A L bF—R—RD/—~ &5
HRANER, BRI DEFEEFDERNDOEFOERA. FRFEFOERMND
EFDERABISEILENHDIBZEL. FIWEDOIIRTO—FELF)Ta—
REEALIER . BADRAL T ERETIRENHIHERLLEITEFTY,

ERFICBIABRELNTOERICESTI5EE. EFOKRFLAEM (F:
[FHAR) TDLDFETCERICEENTLVEWE, EFFLTORRICEHES. B
FITEFDIET NIKEBLBYFET O TERELTIESL,

BEFENTORERICENTS: TEDFERICERE (Duplicate to Staff Above)
LTTDERIZHER (Duplicate to Staff Below) ', [#RE (Edit) >IEX%EIR
LTREY 1T (Paste Special)l ¥ 7 A= a—IZ#HLEMENELE-, 2OARURIEL,
FEDFERICFZE) (Move to Staff Above) L TOEERIZFEE) (Move to Staff
Below) &I TWVET MY, AVR T URR—X M TCIIEIE—T U RR—X M ETES 1=
O BRLEERETDERICELGNS ENTOERICEETEET,

)Fa1—R: DE92ay (VT21—R) TlE. 1 DUEDAURIYILAV LD L
EHLT, SYDLBDNAV R LAV (F—R—R)E D2 avDIBEIE 1 DDAV
ARYILAUR) [CEIVETET , COFRDOINDIRIEEAICEENL T S0
(=, T#R&E (Edit) T BXERIRLTHYMIT (Paste Special) 1)) T1—X
(Reduce) 1D #HLGEMENFELT=,

FP.UT1—RTHEFREMRE (Edit))>IaE— (Copy) i TY)vTR—KIZaE
—LFET RIS AE-LIEBERDOVT1—RELEGD 1 DULEDAURRYILAK
Z#BIRLT. TEE (Edit)>[EXERIRLTRRYKLT (Paste Special)») 71—
X (Reduce) | Z&IRLET,

Dorico [¥aE— LT—%%%’\—ZIJ'%IV*L\ RO ESGEBREITENET VAL
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A—HIIEREE-—DERICI—ILET A=V OERIFHIBRL. FIED A
EDRICERIZE 1 BOHBR—ARSNDEILET, B SDEE, F9%
— 78R F1—[FWMYREFET,

AE—LEBEREZBRLIZAV AR ILAVMIR—Z T BEOEYIRY (L H BRI
;Jim'éz‘n R=ZAREDAVRALYIILAVMEGTRTHGLES 1 DDAV RRYILAY

DEFEZTIRY., DEIZIECTEDAV AR IILAV D EFEERLET . &%
[£.4 DDAVARYIWAVINDEREZIE—LT 2 DDAV ARYILAVKNIYFa
— ARG BEE. BERITLEDAVRIIILAVEMBIBEIZ. 2 DDAV RS ILAV I
ZIZRBEIINFET 5 DDAV RARYIILAVENSEFREIE—LT 3 DDAV ALY
IWAUKMZYT2a—RFBIGEEE VT1—RED 1 DHDAURRYJLAUMZIED
E—TD 1 26H& 2 DODAURRYILAVEID, F#IZ 2 DHIZIE 3 DoH&
4 DHMBH.3 DHIZIE 5 DOMSDEZRMNEYLETOENET,

IHRTO—F: THRTA—REE KD BF 1 2h 2 D) DAVARYILA
VEDEEEZEBRL T, KYZBLDAURARYIILAVMIR—ZARTBHIEEITHRTO
—RIEEVRDLIZBDTY . ChATEREE (Edit) > TR XZRRLTRHEY
(Paste Special) > T2XFO0—FK (Explode) M 5E{TTEDKSITHYELT=,

FITHRE (Edit)|>TaE— (Copy)lZEALT. TVRTO—FIEIEREI)Y
TAR—FIZAE—LFET, RIZ. AE—LIBEREFIIVIRTO—RIEIHEDA R LY
IWAVRE 1 DLILEEIRLT, THRE (Edit) > TRXZRIRLTREY AT (Paste
Special)I>[T/X70—F (Explode) Z:&iRLE T,

Dorico [F. HAFZDAURARYILAVERENE N, TTELEDHNED EMSIEIZ, @b
$ 1 BRZITIMALIICLET . MITEERTHIEFOHAHNEDA AL
AVRE—BTBIGEE . AVARRIILAVRIFNEN 1 BT OZTWYET, 1T
T OAEROBDSHEAXDAVARYILAVMIIYDGENMEE . 2 DELEDA
DARGILAVKIRILERMNEIY HTONETS,
RS—VORBIEELREDBTHTIENTATLE HAXDEFLEFAD (Y
ARYILAVMEEINET,
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BEREIT15—

HZSN/-T%E (Engrave)l>[EZ=HE (Playing Techniques)|# 4 7R4J kU,
BEOBEEREEHRELTHICHILEERTESLSIZHYELT=,

L ] Edit Playing Techniques

Playing Technique Category: Name: Snap Pizzicato

P T

Single / Above Appearance Below Appearance
Mute On

DOverpressure (Down Bow)
Overpressure (No Bow Hrection) (}‘ (

Pizzicato

Pluck With Fingemaits

oo S Ve

Punta d'arco

Saltande :
Category: | String -

Lnap Plzzleata

Spliccato Type: ’G]y.‘&h—v

Sul Ponticello [Bow on Bridge] —
Default placement: i uﬂ|

Sul Tasto

Sul ponticello {sul pont.) Appearance: | Same above and below
Thumb Position

ower text: | snap plzz
. UpBow o i

Playing technique; | Baruok/snap pizzicato ~ | | Edit... |

| HNow | i from Selection

Duration: | Has duration
| Save as Default | | Revart to Factory
Shiown In Cles: m; not shown in Coes |

[ Cancel ] m

BFDEERZZRET S BEORERHEZHEETDICE. 4477 DE LR
(2Bl EEHZDHTI)— (Playing Technique Cateory) | *=a1—m & )%
AT —ZRIRLFET ., ChITREE—FDOMEZRL (Playing Techniques)J/\
FISRRESNESNDTIT—ICRHIELET . BIRL-ATI)—DERBEN A= 21—
DI SCTDIRAMIRTEINTT BIRLTOWSERREN. F(705 0OEHIE L
DBA VI TAE—IZRTENET,

IT45—E BRLEBREEOA(TICIELTHABNEDOYET  [FXRE
(Text) IDEEREFTRATICR RTINS TFAMNERTLET . [T (Glyph)ID
BEHEEIIZT49IICKEEEERTLET BEEBEEIL VDL DOXFE
1 DUEFEALETN. ERIETREIAVM, TXRNIAUL, SHIZIXEZRIT7ZAIL
FTHHICHAGHLETHERTEEY),

T3 Xb (Text) IDERBGAE. COF(T70OY CEERETEET . [TFXE
(Text) I 71— ILREREL TR RTINS TIFAMREZEEL. DI <CHDA=Z2—
MOERT LTI REAWVEERLTHEELE T . TI4HIILATIR ERT ST+
FREAILIE, TEEZERERAT+ 0 (Playing technique font) JICIEESN TLVE
E

R2R—=T Steinberg Media Technologies GmbH
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[517 (Glyph)IDEZRHATIX. MEDDIZE 2 OFATOTEREET, 5
RO LLET T EREEONENRCHNELGINZ&>T. F4705 LEBOKT
LEaA—DT7o2avnN—IZETA(aVN 1 D FzlE 2 DONEIZSRET(D
UM DEORTREINET  RETAIAVEIIVITEEE 2 DIT13—HE
=FET,

Edit Playing Technigue

Name: | comp.stringsSnapPizzicato

| m Text Graphic Composite

Fonit: | Bravusa v |
Rang | stri ] v |
n ¥ v A
m Lel =
=, i ¥ ] ¥
- = - 4 >
S
Zoom:—{_} Salect:| Previous || Next Ly o )| 1 Ly
Component dh A
xoffset: [000 [ wscale: [10000 [  ttachmant from:
¥ offsst: |(}."JU l:— Wscale: | 100.00 H Attachment fo:
Zorder:
Stem
Stem attachment:  X; Y. [(Addaiyoh |
o]

EERRERICHROERZEMTBICIEX. FAT7AT BRI Q/IRRIILNSERLET,
[5Y2 (Glyph)l127hold. FEEDIAVFDEENDXFERIRTEFT [TXR
b (Text) 12T D51 FBED T+ CREAIVDEEE 1 DULANTEFT 14
S5274v9% (Graphic)1#7Mi5lE, SVG, PNG. £l JPG 74—IvbDT 574
A IR—hTEET, [#AEHE (Composite) 2T h5(E, TADIHMEE
THEASNLIBEHFOEERBSZTEMTEEY,

BMLEERE, YORRSYTEEE [AR+XRNF—TCBRHTEET . ERIEZN
FN.NURILOWTRD 1 DEIVVILTESYT 0. TX R5—IL (X
scale)J&TY R4 —)L (Y scale)IDAE AV O—ILZFERAL TR RIEERELE
TEFET VSTV ERIIKEAMEEEARDEREMILTERTEET Y,
GV TR HAEHLEDERICEVWTIL. ERIMARICHETEET S0
ENHYFET,

BHOEZENELRYESEEIL. TRIRDIEF (Z order)I/R2ZEFERALTEIRLE
BEXREFAZICBHIESLLT. RERDRTOAEBERERETEET,

BEREDTHAUNTERELES, TOKIEZ)YILTE 2 ODITFT43—%FL. »
AEA4T7ATIZRYET,
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AMUDIVE2A—IRRILDTFIZHEIZDMDF T aviFE, UTDESYTT,

= H7TY— (Category): A7) —ZFIRLT. COERBEZIRBHE
(Playing Techniques)l/ AR IJLDE DY AVIZRTT DHERELET

" TIHILEDGIE (Default placement): SEXRED T I4ILEDRREES.
EERODIE (Above)IM T (Below)IMIEELET

= 5\ (Appearance): T IJA1TDERREDHITERASNFET [ LTFELRA
C (Same above and below) (3. EEEEZHERD LFIETITRTT DR,
WITNERICEBEEHATHEEZE®RLET . [ ETFICK>TRLES (Different
above and below) | ClE., ERXRD L TICK>TELDREEEIEETEET,

» RyTFH—/"—FFRb (Popover text): CODEZRREFLET =8I
[Shift|+[P] DRy TH—N—IZANTETFFRMEEELES, TTICHOES
BEICEY A TONTWASTIRMNEEET DL ITA3—NEFZHELFET,

m JEZEHE (Playing technique): BARICRBICHKH T 5ERHETT , RIE
ZSBL T,

» Fal—3i3> (Duration): $ESNTWSEEREZOERBRRTOA T3>
A Dorico [T RTREINTIHLVEL =8 FREDITUIDEYRLERFRIZH
AT ER BR. BIUSFEITFLREBEOXENMNEMSINSFETY). REFR
TOHRIEBONFT M., SEORKIZKY ., BERENT I TERERE
£R95 (ITalL—ar&HY (Has duration)]) . 1 HETDELEDHIZ5EFH
shd (ITaL—Yariil (Has no duration)]) NEIEETERKSITHYE
ER

m X3 —TMOFRT (Shown in cues). F1—MNBSBITDAURLYILAVINDE
ERFEZTEODIREICGEO>TNDIGEE. COEEREZEZT1—ICRTTHINLE
WhEHEELET,
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BEROESEREE: %€ (Engrave)*[E@ZEHi% (Playing Techniques) % 1
TR THEERELIZEREEITAT. BERAOESEEICEEM T TL
FI . BEREDNBRERET HLFIC. IEER L (Playing Techniques) A=
—SBIRTEE T, =, [[EEHE (Playing Techniques)| A =1 —E IO R
£ (Edit)IRE2 &) ITHE UTOFI(T7ATNERTEN. BFEOBLERADE
EREEHRELTHI DT ILDEREITHAFTT,

1 Edit Playing Techniques

Playing Technique Group: Name: | Pizzicato

Pick scrape

Alias for: (Unset)

Group: | Technigues v
Pinch harmenic

Pincé Fallback: (Unset)

Ping

Articulation type: | Attribute [ESIETSEET

Pizzicato

Pizzicato alla chitarra

Pizzicato secco

| New | | New from Selection |

| Save as Default I | Revert to Factory I

(orer] I

ELBOIEEHZEDS IV—7 (Playing Technique Group) | A*=a—(. EDY
W—TICBT 2BERDEREAEZRET INEEIRTEET . DI IL—7
[ VST TORTLyiarI v A TERIN. EROBEICEZS20RDE(4T

ZHRELFET,

m WE|ERE (Techniques): &AM I FDMUEICEEFZSZ5EREET
Yo

» 8552 E (Dynamics): Y OURDBEEFIETAVIIEEEEZHESRRE
TY,

= KX (Lengths): BEFEERT5T1L—avP LA—ROTELIOLIHY
DUFDHEICEEESZAHEREIETY,

= EMFEF (Ornaments): EEAFNEVFICHLEMDBEPLELSEEMA T
Y. BOEYFOETS—MEELESERYTHERTETT,
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ERIDTAHT (Name)ll. [%#E (Engrave)|>[®EH % (Playing

Techniques)l. B4 (Play) > TO9XTFLvia>IvT (Expression Maps)].

HXUITHEE (Play)rT/8—hyi3>vF (Percussion Maps)ID5 (4 7HAS A

DIVAMIBNT, COBREENEDIIIZRIREINEINETRELET . BERAD

EREECEEN TN LUTOEEZRETEET,

» IAYFRT (Alias for): IREZEMITIBERADERREFIEELET,

= J)—7 (Group): COBLERADERBENRRSNDT IN—TEHELEFT .

» 8% (Fallback): COEFRFENERTEGNGE . MOYICERTIBER
DEREEZEELEY.

" P—F4¥aL—avDRAF (Articulation type): BERADEEHENEZ
BMBRDTaAL—23 FEELET [EEF (Attribute) |[EZDREDEFD
AITERAIN (RAVI—FDT7—T14FaL—3 7E), [H#E (Direction)](d
LBEOTNTOERIC, thDERBEICI>TRYEENSGEFTHREZ G AT
F9 (EFH—FDIETRELE),

ERERATLIOKIZD)YILES . CNT WEFEHFRIEBLSN-BLERAD
BERBEETOOIINTHRATESSIITHYET,

WELILEREEZ#MOTOC IV CHERTESKS1295: T1%E (Engrave)l»
[7RZ=BGE (Playing Techniques) TiTH>T=#w&E(E TR T, TI7AI/ILLTIERE
OTAVTIMIFHTEREINE T FIREREIIREL-BEROEZREZES
BIEBT BT R TOTADIMTHRATEDLSICTBICIE. FA4T7RTE/DY R
EABERLE T HERHEEZTEIRLT, [TI4IMELTRE (Save as Default) 12
YOLET . COERBER. SRIEBESNLGTRATOHRAITODIMIRBEN
EX P

T4 I DEERRRICNAT-RBEEZRICRTICIE. FAT7ETER/ D) XM SR
LI OBRFREEHERL T THEROEEICRT (Revert to Factory) &5y’
LET,
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FEEZFREIAF VM Petalumal

Dorico 2 [ZI&, FEZTDEE I+ I73)—THAPetalumalhiFit=IZmH Y E
Li=o D773 —IX, Petaluma]. Petaluma Textl. IPetaluma Scripti® 3 D
DI+ TEBRENTWET, [Petalumalld, ROA7H DI R TOFREELESIZHER
SINBADTHURTT, [Petaluma Text)lE, ANA/—LT—9, 3—RES.
BB LE. TXFRAMDEIGTATLIZEEZRAFEFNLGEEESICHERAINET,
Petaluma Script)l&. RA7HFDZ DT R TOTFANTOFERIZE LRV T
FI+2bTY,

INTRO
Bsmaj7 Esqen

e

Petaluma 773!)—I&. Jazz Standards Z&k>—kMLGEEEE CHERASINLFE
ERAMIITES EZFEDNTNET AL, 1350 U LDEHRESE 500 ULEDFR
DLN—R)—%FL. CNIEEEEYFTHITESATOAERYDF TE, (£5HHIC
NITTA—ISETIDELGYFET,

7O LT Petaluma #EATAICIL. I$F (Engrave) T HEI+2k
(Music Fonts) 1% #RL . FRATELEE I+ DY XD S Petalumal#EA T
TOKIZZ)woLET , ZhlzkY. TPetaluma Script1H 7O OD T I4ILED
THRRARNITAUMBYET D TF R IV EERT HI5E 1L, [5E
(Engrave) > 7> X541 )L (Font Styles) IO FI+ILbDTEXAMAT+U b
(Default text font) ], H XU HE (Engrave) >TERERX AL )L (Paragraph
Styles) IO T74ILEDTF AL (Default text) |1 Z#mELET .

Petaluma (¥ SMuFL E#tDEHE I+ +THY. SIL Open Font License (OFL)
DAV REZITTWVET, LIzA>T.OFL O TFTEEZVI—XTERYIE. B
HICHEA. £8. BAZTEAFET. [PetalumalEFZD I+ b I73)—DFH T+
JhRTHY . IRETHUMNICD T BEFRATEFE A &KIC, T+ T72
|)—TPetalumal B8 XUPZDIRETH U ME. BRIICERFETEERE AN, RSN S/
r—TD—EELTERMTEET,
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NotePerformer 3 MHR—k
Dorico 2 [&. Wallander Instruments [Z&% NotePerformer 3 DY HR—rHEA
LTULVET , NotePerformer (&, EEEERY IO 7 (ICEHBEDT=HIZHFAIZE
HENFN—FYILLVRRYILAVERTT,

NotePerformer 3

, . B | G | Grchestral
Otiou Clarkel  Bassomn  FoHan  F Hom  Trumpst Trombong e i Timpari Pertassio Vidlins  Vicding
L] ® L ] [ ] [ ]

AE (R1} L7 ik} "1 R21 Ri2 3 c

100 108 100

100 100
L] . I| . . .

100 160 100
I L] . . L

L]
3 REVERE REVERD AEVERE REVERE REVERE REVERD AEVERB REVWERE REVERS AEVERS RAEVERE REVIAB

NotePerformer 3 & Dorico 2 IZRESN TLVEH AN,
www.noteperformer.com KYRBIREATEET, Tf-. ZTH5 30 BERISAT
JLREZ D O—RTEET,

NotePerformer 3 #fEALA>X+—)LLT=# Dorico TERT BIZIE.
NotePerformer Z#EALTELEZTH570 /2 ME. TB& (Play) " [B&ET
> FL—F (Playback Templates)|#Z#RLET . BETUITL—FDJ XM
[NotePerformer | ZEiRL TIOK1Z 2V ILET,

NotePerformer 23 R TOHFHM IOz H/MTHATHEE L. BRERTE
(Preferences) DI £ (General)IX—C DIHBA (Play)ltoiavizhblT2
#IEDOBETTL—F (Default playback template) 1% NotePerformer]Z5%
ELET,
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ERFFACS

HALion Sonic SE ®Z®D#®D VST /—+rIHRTLyiavstit VST 3 12Xk
ILAVMIBENWT, BARBLUEELOETHRIRFOELBEORIC. MOS0
PREFEL S A EREICHESNSLIICRYELT=,

A—T1AEEHL

Mac LU Windows T, A—TA4AEZHLPDOEFH T A F7OIDRREINDEK
SIZHY, RITHOEBROERF LY EREICINBETEDRSIZHYELT=,

INERT R

BEIRAIAILD RE/NETER: The New English Hymnal Z2ED—E3DEEE(C
[F. RIEE/NDEIROIMBFEHEENRONE T, TR TOAR—RDMEICAMN KRS
N HLRERVRDHAEHLEDNMDYIZ 2 AOMULVNEIIEAEINET . 1=

ZL. fAERDBIAGIE LB T, INETRAEC 4 DD RETHARTEINET,

AT arlING# (Barlines) IR—PIZHAIRILHEICHIREFLS (MR
D48 (Coincident repeat barline appearance) 1T #iL \{E#t## (Double thin
barlines)JIZ. 'JE—F®D mD# (Repeat dot frequency) IZTF#HFRADTRTHD
AR—ZR (All spaces in the staff) ][ E T H_ET. CORERAITHIETES

FOITYELT,

INTEE

EAROMEGESDEHE: RAFICEFNAH/NEESDHEEZRRTTEDLIITK
YELTz CNFRAFOETICRIRINET . CWEBRITTBHICIE. LAT IS
TiaoOlINGES (Bar Numbers)IR—JI2H 5 RUWF TIT/NHES OHEH

%#% 7~ (Show ranges of bar numbers under multi-bar rests) | %74 (ZLFET,

FEA TV OIMARF (Rests)IR—TICHLWA T avhBmMESh, EREZD
TONESDHBERREDT IAICDEREDEREL, SEFERTD 1 DHE 2
DPHDNMIBESDRYUYXFDIEEZITEASLIICGYEL =,

BRBLATINIEFTZNEHESONER: LAT IO TarnliINGES (Bar
Numbers) IR—UICINSTSTREAIHBF LA T avELTEMSA, TADT
IRDBELATIMIEDINTGTSTRIAINEFERTEINEBIRTELLSITHYEL
t2oe FRTOD VT TNV AT B LUVDRZLZTHNINHEE (R27)
(Bar numbers (score)) IN/NSTSITREAILEFERTE—H., I8\—rL AT IR
FINES (/3—F) (Bar numbers (parts)) ID /NS5 STR B/ ILEERALET , BX
FEOTODIHIRTIE, RATLATIRENR—LATOROVWTNENNEES (R
37) (Bar numbers (score)) 1D /NS5 5TRAAJLEFERALET A, Tl Dorico
1X THEASND/NEBED I+ LRI/ IILONBRIZ—BHTILSICEHFINATE
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Y. Dorico 2 T/OPzVMERVWTEHNMIBSONENEHLLELNKSIZLTNVE
ERR

T4 ILLTIE, IMEIES (Ra7) (Bar numbers (score)) | ETNES (/8—F)
(Bar numbers (parts)) |D /T 5TRFAILIEWNVTNERECHERZEFEETH. #E
AZRRAIWEFDIEITKY ., IIWRATICHEEEZ T IA—kL AT OO
EBESDIAUM YA X RA WV EHBRICERTEET,

O—FEEE
HS5—: a—FREEHN, Ta/8T74DI—f& (Common) % )L—T DIHS5— (Color)]
TONRTADEREITRSILSITHEYEL =,

=
EESLUBAT CTHERASNSGF LS EIEET 5: Dorico [ZT)ybIhTLVS
ADVRRGIVAVNIATIZIE, EBEBRATDEELZRTITIRIEN TN ELLE
HESEEAITIEOLAHBYET . BEICGLT,. 7ZB—DEHREETNTNIZCH
FEEIBEECEDLIITHYELT, [#REE (Edit) T FEEEE (Clef)l I A=a—
(2. T5EF (Concert Pitch) 1£T#EE (Transposed Pitch) | 2 DDH T A=
—FLGEMENFEL -, CIALIE, BRETE—FDIFHEES (Clefs)l/ARILHDS
FIATESAT R TOEMREESNBIRNTEET,

Jjn

SRESECS
BBESDERTEY DALY BEMRBELESICEABETXFAMNELERETTAL
NIKIZE . THERAM—AD BRI S N NETREF-CIEa . FIEI<E
*L&%k:ﬂtb'& MBS MNERORNAICRESNTLESISE . RIS T/
ROERIEO—EEEYDSEDEINTTHET BBEREIIEYFRA LT
YFEJ,
TO/RT4 )L DI5EFEES (Dynamics)1J IL—T (2 [EREZEYDSL
(Erase background) | 7O/ AT A F Iz ITEBMENFELIz, ThiE, FEE—FTOD
HARRINET , COTONTAEA VT HE, RIBESRADOMEHEADLEYD
SENFET, RBELEBRALOREBDTIAHILENDRESIL BEATav D45
28 (Dynamics) IR—VICH ISR EBE SN -IEBREERLNEREEYDOAL
1-%& B (Padding around dynamic with erased background) | D{EIZ kYR E
SNFET, TaNTaN\RILDIAFFEEE (Dynamics) 1V IL—TIZHFHzIZERESH
t-TRE%i4% (Erasure padding) 17O/ AT BMIL TR EELEZTEHIL
L TEEY,

REDHIRERET B, Dorico [FXBEBTFAMSLIUERETFRAMNE, F14F3y
ILRIVETTHR—ILRAR) AN XFEIIRALTRET =8, frisoluto MK
SITABRSICRAETRTABE.f D-HDOERAIL risoluto D=HDEALYE

RAGYFET . REIE. TIHILNTXFOLTADEEHLIB R ITE RSN S5
Dorico 2 /\—Lav B 40 R—2 Steinberg Media Technologies GmbH
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BB EDEDES TINIREFCMIZKo T, BYD SRS BMEEABELL
FIZKECRABBENBHBYET, =LA X BRBIEBEDFRETF AN espressivo
M plTIHELTs1DER TNEREF-CIHE. RBREFTDTORENKRETES
FOTRAFT, COMRRELT, RBESEALOREAD 4 AAZTNETNDKRE
SEEAMICEEETEET, TRFRAMDEEHLEBA LY FTETREZILIFALELSIC
TREZELLT, BYDSLE-EENAXFO LT THMICRASLSIICIRELE
ER

BYDSSN-RAMBEEIL, RBLSOEREE#ADRRABREEBRT S5 —HRELT
RGEhZxEd,

BIGDLDSTATEY: BIGDLEMOI=ATEU X, FAFIVILRILD 2B
BRFLIEFLERTOIC—BOERMFICL>THERASIN. [RBGATEY 1&
FIENDIEEELHYVET . ATELDRIFIZIEDYEFITDIZIE ATEUZEEIRL
T. HLGEMSN-TREDIEMY (Flared end)] 7O/ T4EAVIZLET . CDT
ANTAIEANTED ELTHEINDELFEHITAEEE S T, ERTHEINDI LD TOHE
ATEET,

BIRDENYD T I+ILED YA XL, FEAF T3 DIAFEEEE (Dynamics)]
R—S DI EERERTATEEES (Gradual Dynamics) ]t o< av(cEiskan =Tt
[EA21=TH (> (Flared end design)1V IL—T DA T3 EEBLTHEEL
FTMERDATELDRIGEDENY DY A XL, FEE—R T, FILGEMSN T
[EMYDHAX (Flare size) | 70/ T4 DIE (W)IETES (H)IZZELTREL
EX

T4)L3—

MR (Edit)1>[ 748 — (Filter)]A=a—|2<v—Hh— MY E—MEBE LU R
Sy a B ABMEINEL =, T TAIINE—AZa—(F. BHYYIIZLKBIVTF
ARAZa—DRIZEFENDLSCHoT-1=8 ., BHEICFUHE T IENTEET,

248G

HRBLGER: TONRTANRIILDII40HY2% (Fingering) 17 IL—TF 1T R4r—
JU (Scale)l 7O/ T4 HFHLGEBMEINEL z, CNIFIFEE—RFTODHARITIN, T
AVAN T DRTEREE . TNHIBTIERORTERLIEANERTEET,

B T4 HI T ONE: TRINTARRILDI D40 H) 2% (Fingering) 157 )L—

FIZHLGEMEN-THYEEREES (Cautionary)1h b, BYI T4 AHY T D5
ZEBICLEEETEDLSITHRYELz, CNIEFEE—FT (T4 HIUT TIEHK)
BRNBERSINTVALELETRIRINET, COTONTAIE BT H)Y

NMIW-BRDIGETOHAAVICTEET , TALUSNOERTIXESHNIZAIIZR
SINFET, TANTFADFUITGEDIE UTOEISEIRTELLSIZHRYET,
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m TIJ4J)Lk (Default): #HEF TV THRESNBU T AT DNEEE
ALET,

= EII%L (No parentheses): 74> H) VT #EIMLZLTRRLET,

= {FEDF (With parentheses): fElZE{TIFTTIA AN T ERRLET,

= 1%l (Suppress): HU T« H I T ETEIZERTIZLETS,

HAFEFIETRGEDTAHILT: T4 I TIZAVEARRE L TEET
(FHIEMTEDLIITHYFEL = COXIGEMITI—T 1AL DT4HIT T
FRASNDGENHY B TANILTITERESATERTHILERLET . CNEE
ETBICIE. T4 AT BBERIRLT, TANTANRRILDI T4 H)T
(Fingering) 17 IL—7I2HLGEMEN I TaL—3 3> (Decoration) | 70/ T ¢
EAUICLET . CNIEEFEE—RFTOHFRTINET FEF T a>DIM240HY)
2% (Fingering) IX—2 DI FH A2 (Design) 1ty 3> CIEMETE
(Advanced Options) 1TV avEa BT 5L AV BEABRD T4 X BOKS
BEDATLavEH/ETEET,

Fyl—Ea—
REABADERINULBSSIUVRELROERD LO/NHESDY A XEMENRE
ShELE,

HALion Sonic SE
Dorico 2 [& HALion Sonic SE 3 ##&LEL=. HILLWN—C3  AICEFH SN
ARL—230=aFILIZDWTIE LT YA RESRBLTESLY,

https://steinberg.help/vst-manuals/halion/halion-sonic-se-3/

SXH—
R)a—LI7z—F—F=F/\>arba—)LIZHEWT, [Ctri]+21)v% (Windows)
F71zI& [Command]+V')vy (Mac) 3 5&. TI7AIMEIZ YR TESLSITHY
ibj—:o

BF
FELGLOER: TO/RT1NARILOIEFELAKSF (Notes and Rests) 17 )L—(C
[FFEB%IERT (Hide stem) T O/ TA4DFT=[TBMENFEL, CHITEEE—F
TOHRTINET . AVITTEHLEEBRLE-BROFTENRTRINGAGY | REFIC
FBIERTRIBVET . BRLEBEANEHTDT IL—TIZA-TVSEE. BE
[FIERRICHEYET M EMIEEEEBVIZRRSNET, =L, EHTOTIL—F
[CBIAEHIRTTIHRZIERT (Hide stem) | TO/NRTFAAFUIZHESNT-
HEIE EMLERRFICHYET,
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BHAOAN

BEOBEFEEFICHAAD: ERLEBEOERZ 1 DL LEOERF(ITHEAA
HBFIINBEYFEL = EFICKIRI HDEFERERLT.I;) (£3aAY) ZHLETS,
BRORYTA—N—DFHE EBRL-EFORET AL —LavhbiREShSHLE
EARTEINET . BRESNLERDFEFE, FLEEBRDOLEEREZAALTHL.
[Return] ZILTRYTA—N\—2HEELF T, BIRLI-EFINIEELILLEDE
FF 1 DICIRFEDGEEIL ERA 1 DIEHERSNET  IEELI-LEENRIRLT

BERHIANTEEHRALICET T THAERIE. BRUITRTOEFFAERIC
WESETEMDEFNMERLSNET,

ERDOT2L—avIcicTdIXF 2h=2 2FF.w= £28F.h=2 2FF.
q=4 NEM.e=8 NEFREL) FEBRFAADTIAIIDF—R—Fa—k
AVRZEITETAL—2avICHIETHHF 9=2 £5/R.8= 28/F.7=2 5
Ef.6=4 2ER.5=8 DERLL) 2AMTEILIKY . ERDIBOEEE

BRDRY TA—/N—[CEFEEETEALIITHYEL - T2 1 DU LEDRIER

(EUAR) XFEMALET, (FTRAESDROBMUAEFRETEET, TaL—3>
DIREICHFEERTL5E. HBLHOBMEZEAR—ZIANNATUTRYZLE

DHYET 12EZ X, T5:4q.11ETFE 4 HEF 4 DORESITED 5 ERFIERY.,
3:2-2w]l&l2 £8F 2 DORSITKD 3 EFIELGYFET,

BROAR—IY

XNILYDRE: BET HERDANILTHFRAEMLENESIC. FEDELIZH
THEREDSAONEL =, HEMLESTGEIE, FERMICTRGIRICEREAAERD
nEJ,

HE S

ITEBOLOIVR: ITRBOLS VRN YNNI IY—IELVTURERTF
AFDORAAIZERESNDKSIZHEYZELT,

B&ETUTL—

BATUTL—HMIIE. VST 4V RRYILAVREEIE MIDI TRAZRMSDH IR
Z7ACT MDAV RRYIILAVMIERE S 518 Dorico hMERTSH/L—ILHYEE
BN TWET, SNETIE, TIHILLDBETUTL—ME 1 2FZFT. 7O
DB\ EIZ HALion Sonic SE DAV RAVAE LU ARESINTLYS HALion
Symphonic Orchestra & HALion Sonic SE D547 35 —Ma TV FERALT
WELIzZ AUSFILDYIURERIE VST AV RRYILAVREEIYHTT, T4
IWDBETUIL—OERE LEETHILIETEELRLD. TNETESE T
AICOBETUIL—rDOBERAZERTRLELRY . Dorico IFBATHIURFDEY
BTCEITEDEIE>TUVEL,
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TIAXICDBETUTL— b HEEOAMIHETHS Dorico Elements (&,
HALion Symphonic Orchestra ERZEEHLTLVEW 0. TI+ILEOBAETIE
HALion Sonic SE 54 73—Da TUVIZEEITIKEFELET . 2D 1=, Dorico
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ID# Component Issue
STEAM-4241 . Changing the pitch of a grace note before a barline no longer incorrectly considers the
Accidentals . .
STEAM-4294 accidental state of the following bar.
STEAM-5539 Accidentals Whep using the Second Vlenne§§ School accidental system, gracg notes are now
considered correctly when determining whether or not to repeat an accidental.
STEAM-7472 Accidentals Under some rare cnlrcumstances, |t. wgs not possible to change the pitch of a note that
had been respelled in a part layout; this problem has now been resolved.
STEAM-7910 Accidentals The enharmonic spelling of rising chromatic passages in minor keys has been improved.
STEAM-7905 Audiolexport A progress dialog now appears during audio export on.both Windows and Mac, and
accurately reflects the actual progress through the operation.
STEAM-7047 Barlines _Dashed bgrllngs to show subdivisions in additive time signatures no longer fail to appear
if the bar is split across a break.
STEAM-7077 Barlines Creating a tlrln'e'S|gnature char?ge at a dashed subdivision no longer causes previous
dashed subdivisions to appear in the wrong place.
STEAM-7134 Barlines Repeat barlines no Ion_ger draw .|ncorrectly at the end of a system if they coincide with a
key change to a key with no accidentals.
STEAM-7301 Barlines Inserting a t_)arllng at the same rhythmic position as an existing dashed subdivision in an
aggregate time signature now works correctly.
STEAM-4846 BeEming Praggmg the end of a stemlet now works correctly when the stemlet belongs to an
implicit rest.
STEAM-7562 Chord Toggling the Show as mode property on and back off again for a diminished half/whole
symbols scale chord symbol no longer results in the chord symbol showing as a different chord.
Collision Mysterious problems where deleting an item can cause an item in another bar to move
STEAM-7504 . . . .
avoidance vertically in galley view have been resolved.
STEAM-7716 Collision The extent of items is now always correctly considered for collision avoidance when
avoidance editing an item that is graphically wider than its rhythmic position and duration.
STEAM-7018 Cues If a cue abuts the end of a flow, a redundant restorative clef change is no longer created.
STEAM-7029 Cues Cues are now automatically removed if they are invalid under more circumstances.
Edits that affect where instrument changes occur no longer sometimes cause system
STEAM-7505 Cues objects to disappear if a cue is located within the range affected by the edit.
STEAM-5064 Dynamics Edit » Reset Appearance and Reset Position now work correctly on dynamics.
STEAM-6385 Dynamics If a dynamic has a color set V.Ia Properties, it now shows corlre.ctly in the blqe linked color
rather than the orange selection color when another dynamic in the group is selected.
STEAM-6651 Dynamics A series of gradual dynamics interspersed with immediate dynamics and shown as a

single hairpin no longer draws incorrectly in galley view.
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ID# Component Issue

Under rare circumstances, edits that affect the vertical placement of gradual dynamics

STEAM-7328 Dynamics would not be propagated to all music frame chains; this has now been resolved.

Adding an immediate dynamic to the end of an existing group of dynamics now correctly

STEAM-7742  Dynamics extends the length of the flow if required.

STEAM-7782 Dynamics Hairpins that extend precisely to the end of the flow now draw correctly in galley view.

The Indicate shift to next note and Shift direction properties for string fingering shift

STEAM-7257 Fingering indications are now correctly reset when pasting notes onto non-string instruments.

Deferred fingering substitution now works correctly on notes and chords that are tied

SRR TS Fingering between different voices.

Under some circumstances, fingering substitutions could fail to draw as slurs, despite

S AT the options or properties; this problem has been resolved.

STEAM-7217 Flows Duplicate Flow and Split Flow now correctly copy the flow info for the original flow into

the new one.

STEAM-7697 Graphics I_mported graphics are now exported at a much higher resolution when exporting PDF

export files.

Graphics It is no longer possible to change focus to another project in the middle of a graphics
STEAM-7767 . - . ;

export export operation, which could cause graphics from the wrong project to be exported.
STEAM-7848 Holds and In some circumstances, a fermata on a bar rest could be incorrectly positioned at the

pauses start of the bar, rather than over the bar rest; this has now been resolved.

Key Adding a clef change at the same location as a key change now always correctly
STEAM-4826 ) . :

signatures updates the cancellation naturals, if shown.

Key Changing the current tonality system in the Tonality System section of the Key
STEAM-7618 . .

signatures Signatures panel now always takes effect correctly.
STEAM-7628 Key Creating a key signature from the Used in this flow section now always uses the

signatures tonality system selected in the Tonality System section of the Key Signatures panel.
STEAM-7796 Kgy The .tonallty sy_stem shown in the panel in Write mode is now always used when

signatures creating a key signature.

Changing the keyboard language on the Key Commands page of Preferences now
STEAM-7374 Localization works correctly when there are unsaved changes to the key commands in the current
language.

The default key command for Write » Respell » Respell Using Note Above now

STEAM-7563  Localizati
ocatization works correctly in the German-language version (Windows only).

Using the left or right arrow key to navigate off the first or last lyric no longer incorrectly

STEAM-7361 Lyrics loses any edit made to that lyric.

STEAM-6243 ZZ;z-bar Multi-bar rests are now broken by both the starts and ends of repeat ending segments.
Multi-bar The presence of a system break no longer sometimes causes the width of a multi-bar
STEAM-7065 :
rests rest at the end of the previous system to change.
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ID# Component Issue
MusicXML Exporting with Export layouts as separate files switched off now correctly finds and
STEAM-7423 .
export uses the most appropriate full score layout for the selected flow.
MusicXML i i .
STEAM-6118 import Imported MusicXML and MIDI files now respect the Default text font family preference.
MusicXML A problem that could cause Dorico to crash when importing MusicXML files from
STEAM-7391 , .
import PDFtoMusic Pro has been resolved.
Moving the selection between non-note items with the arrow keys no longer sometimes
STEAM-7957 Navigation causes the selection to jump unexpectedly to the start of the previous system in page
view or backwards several bars in galley view.
Notation The Overlapping notes in the same voice in a kit or grid presentation option on the
STEAM-7487 p . . . . .
options Percussion page of Notation Options now works correctly for chords split by a barline.
STEAM-5499 Note input Inputting the first note in a new voice between rhythmic grid positions now works
correctly.
Under some circumstances, extending the duration of a note that ends within a tuplet in
STEAM-5555 Note input Insert mode could cause other later notes in the same voice to be deleted; this problem
has now been resolved.
. Changing the voice of a selection of notes no longer sometimes causes the notes to be
STEAM-6546 Note input moved to a different rhythmic position if items already exist in the destination voice.
STEAM-7411 Note input Pasting a selection beglnnlng' with implicit rest; immediately followed by a tuplet no
longer causes some non-note items to be offset incorrectly.
STEAM-7411 Note input Pasting a.selectlorll that begln.s Wlt.h implicit rests fgllowgci_ by a tuplet no longer results in
non-note items being pasted into incorrect rhythmic positions.
STEAM-7425 Note input Pasting a selecfuon including tuplet§ into an eX|§t|ng passage with |d_entlcgl tuplets with
chord mode active no longer sometimes results in some of the material being offset.
STEAM-7449 Note input F’astlng materlfal of the samg d_uratlon as an existing tuplet will now remove the tuplet,
instead of pasting the material into the tuplet.
STEAM-7561 Note input Upd_omg the creation of a tuplet no longer sometimes fails if a non-note item is located
within the range of the added tuplet.
STEAM-7609 Note input Making a selection on a percussion .klt using the five-line staff presentation type now
correctly uses the extent of the selection from all components, rather than only the first.
STEAM-7657 Note input Copy and. paste for instruments Wlthlnl a percussion kit using the single-line instruments
presentation type now works more reliably.
. Dorico no longer hangs when attempting to shorten with Shift+Alt+left arrow a note or
STEAM-7748 Note input rest of the minimum valid duration (1024th note).
STEAM-7880 Note input l\/'lovm'g the caret after priming a new voice no longer causes a voice with the wrong
direction to be created.
STEAM-7939 Note input When multlple |.tems gre selected_, hitting Return now starts note input, rather than
attempting to edit the first selected item.
STEAM-7490 Notes Stems in opposing directions on adjacent staves are padded by a small amount to

prevent them from becoming so close they may appear to touch.
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STEAM-7508 Notes Rhythm dots on stemless notes— i.e. a whole note (;emlbreve) or !onggr —in down-stem
voices are no longer incorrectly snapped to spaces in the wrong direction.

STEAM-7436 Ormaments Glissandos between invalid note po§|t|ons (for example, two notes of the same pitch tied
together) are now correctly automatically removed.

STEAM-7568 Pedal lines Making a §elect|on on the lower or left-hand staff of a piano instrument and then pasting
the pedal line now works correctly.

STEAM-7684 Pedal lines Pedal lines t.hat span multiple systems no longer sometimes disappear when making
unrelated edits.

STEAM-7487 Percussion The notation o'ptlon to removg oyer!aps for percussion kits did not always work correctly
for a chord split across a barline; this problem has now been resolved.

STEAM-7568 Plano. Pasting piano pedal lines now works correctly when selecting something in the left-hand

pedaling staff of the piano.

STEAM-7516 Py !t is no longer |ncor|fectly possible to use the Shift+l key command to add an additional
instrument to a section player.

STEAM-7290 Print mode Th_e chosen page range for printing is correctly preserved when leaving and re-entering
Print mode.

STEAM-7323 Print mode Choosing a page range that does not .|nclude.the first page of the layout, then switching
back to All pages now updates the print preview correctly.

STEAM-7764 Print mode Cancelling a print or graphics export operation no longer sometimes causes a crash

Repeat . . . L .

STEAM-7199 endings It is now possible to create a repeat ending when an explicit bar rest is selected.

STEAM-6760 Rests Setting a property on ap implicit rest no longer causes all other selected items to be
removed from the selection.

R The Bar rest design in long time signatures option on the Rests page of Notation

STEAM-7012 Rests Options now works correctly when adding bars to the end of the flow.
The presence of local time signatures on one staff no longer prevents multi-bar rests

STEAM-7545 AR from appearing in the other staff if they line up with the bars of the global time signature.
Expanding a group in the Players panel will no longer cause the cards for the players

STEAM-5501 Setup mode within the group to be truncated incorrectly when the group is partially scrolled out of
view.

STEAM-5817 Tempo Tem.po items W|.th dx/dy offsets are no longer sometimes positioned inconsistently in
relation to other items.

STEAM-7473 Tempo The §pacmg of rhythm dots in metronome marks has been improved, particularly for
durations shorter than a quarter note (crotchet).
When the font style for gradual tempo items is set to absolute rather than staff-relative

STEAM-7706 Tempo size, the dashed or dotted continuation line is now correctly drawn at absolute size too.

STEAM-7723 Tempo Gradual tempo items with no drawn continuation line now draw a handle and attachment

line at the right-hand end in Write mode.
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ID# Component Issue
STEAM-6777 Text System-gttgched text can now be edited correctly if the top staff of the system is hidden
because it is empty.
STEAM-7536 Text Right-aligned text is no longer sometimes slightly truncated within a text frame.
When considering ties for the purposes of collision avoidance, the inside of the tie was
STEAM-7578 Ties incorrectly being considered instead of the outside. This problem has now been
resolved.
Time Under rare circumstances, notes and rests could be grouped incorrectly in irregular time
STEAM-7075 . . - . . D
signatures signatures within an aggregate time signature; this problem has been resolved.
Time Undoing the addition of a local time signature to an individual instrument now always
STEAM-7587 . . . X .
signatures correctly reinstates the previous global time signature.
STEAM-7561 Tuplets Undomg the creation of a tuplet where a non-note item'’s position overlaps with the new
tuplet will no longer go wrong.
STEAM-3656 User interface Qrop-down menu§ in dla!ogs fand papels po longer .sometlmes appear on the wrong
display when running Dorico with multiple displays (Windows only).
STEAM-7510 User interface Focus no longer gets Ios.t after pllcklng_thg buttons in the lnote input toolbox, resulting in
key commands not working until you click in the score (Windows only).
STEAM-7637 User interface It is now possible to assign key commands to both File » Import » Flows and File
> Export > Flows.
STEAM-7647 User interface The varlous. annotations that appeqr at the top and bottom of the caret are now correctly
scaled relative to the current staff size.
STEAM-7663 User interface Maximizing the document window while a modeless dialog was open could in rare

circumstances lead to Dorico hanging; this has now been resolved (Mac only).
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@ steinberg
Known issues and solutions

Frequently asked questions

Answers to frequently asked questions about Dorico can be found online in the
Dorico forum.

Knowledge base

For the latest information about issues and solutions you may encounter when
running Dorico, please consult the Knowledge Base.

Entering the eLicenser Activation Code (Mac only)

When you first run Dorico and are prompted to enter your Activation Code, you
may find that after you have successfully activated your Soft-eLicenser, you must
quit and restart Dorico for the application to detect that it is fully licensed.

Key commands to transpose notes by an octave (Windows only)

The Intel Graphics Adaptor drivers used by many Windows computers define a
default key command to flip the screen by 90, 180 and 270 degrees via a shortcut
Ctri+Alt+up/down/left/right arrows.

Ctri+Alt+up/down option conflicts with the key commands in Dorico note input for
transposing notes by an octave.

For information about how to disable the default Intel Graphics Adaptor key
command, consult the Knowledge Base.
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